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1 ОБЩЕЕ ОПИСАНИЕ ПРОГРАММЫ 
SURFACESCAN 

Программа SurfaceScan – это специализированное программное обеспечение для 
управления работой атомно-силового микроскопа (АСМ) NT-206. Специализация позволяет 
наиболее полно использовать возможности аппаратной части прибора. Программа SurfaceScan 
позволяет производить настройку систем измерения АСМ NT-206 и управлять процессом 
получения АСМ-изображения поверхности с последующим сохранением измеренных данных в 
файле специального формата, содержащим набор всех полученных при одном сканировании 
АСМ-данных. Расширение сохраняемых файлов данных – *.mps или *.spm. 

Программа SurfaceScan – 32-битное приложение, исполняемое в операционной системе 
Windows XP SP2 и выше. Программы состоит из функционально законченных компонентов, 
управляющих работой АСМ NT-206 с виртуальных панелей. Пользовательский интерфейс 
программы организован по принципу аналоговой установки параметров с помощью виртуальных 
кнопок, выключателей и регуляторов. Дополнительно для более точной настройки 
предусмотрена возможность параллельной регулировки установок в цифровой форме. Доступ к 
большинству функций программы, процедурам установки и регулировки в панелях управления в 
большинстве случаев ориентирован на применение мыши.  

1.1 Установка программы 

Программа SurfaceScan обычно устанавливается в управляющем компьютере 
специалистами, обеспечивающими наладку АСМ NT-206, и не предусматривает процедуры 
автоматической установки. Тем не менее, её самостоятельная установка пользователем на 
новый управляющий компьютер (или переустановка для использования в обновленной 
операционной системе) может производиться в следующей последовательности. 

1. Создать на жестком диске папку для размещения рабочих файлов программы 
(например, SurfaceScan215 или SS215) и скопировать в нее из установочного пакета 

(или пакета обновления):   
- исполняемый файл SurfaceScan.exe;  

- файлы динамических библиотек bulk.dll, hcl.dll, fmps.dll, sxds.dll, 

dscls.dll, fspm1.dll, fspm0.dll, fmtf.dll;  

- файлы конфигурации hcl.ini и SurfaceScan.ini. 

2. Из папки System32 в установочном пакете скопировать в системную папку System32 
(обычно C:\Windows\System32) ресурсные файлы: 

bcbsmp60.bpl 
borlndmm.dll 
cc3260mt.dll 
dbrtl60.bpl 
dsc.bpl 
dscls.dll 
flatctrl.bpl 

JclC60.bpl 
JclVclC60.bpl 
JvCoreC6R.bpl 
JvCtrlsC6R.bpl 
JvRuntimeDesignC6R.bpl 
JvStdCtrlsC6R.bpl 
JvSystemC6R.bpl 

rtl60.bpl 
stlpmt45.dll 
sxds.dll 
vcl60.bpl 
vcldb60.bpl 
vcljpg60.bpl 
vclx60.bpl 

Данные ресурсные файлы используются в большинстве программных продуктов ОДО 
«Микротестмашины», поэтому их размещение в общей ресурсной папке операционной 
системы предпочтительно.   
Примечание. Данный набор ресурсных файлов автоматически записывается при установке программы 
обработки и визуализации АСМ-изображений SurfaceXplorer. Таким образом, если программа SurfaceXplorer 
была ранее установлена в системе, то данный шаг можно пропустить.  
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3. Для обеспечения связи управляющего компьютера с блоком электроники управления 
АСМ NT-206 подключить специализированные USB-драйверы. Для этого 
необходимо соединить USB-кабелем управляющий компьютер с блоком электроники 
управления АСМ NT-206 (из комплекта АСМ NT-206) и включить блок электроники 
управления. При первом включении операционная система произведет поиск 
необходимых драйверов и в случае их отсутствия запустит процедуру их установки 
(Мастер).  

 

 

Перед подключением кабеля связи от компьютера к блоку электроники 
управления АСМ необходимо убедиться в наличии и функционировании заземления 
в розетках сети переменного тока, питающих эти устройства. При отсутствиии 
заземления необходимо как минимум обеспечить зануление потенциалов 
компьютера и блока электроники, соединив их корпуса отрезком провода. Также 
рекомендуется запитывать управляющий компьютер и блок электроники от одной 
фазы (например, через один удлинитель с фильтром).  

Дополнительно рекомендуется проверить правильность конфигурирования и 
работоспособность USB-порта в управляющем ПК (включая BIOS компьютера). Для 
корректной работы системы связи через USB-порт рекомендуется использовать 
управляющий ПК на базе чипсета Intel. 

 

Последовательность установки драйверов Мастером проиллюстрирована ниже. 

 

Выбрать опцию «Нет, не в этот раз» 

Шаг 1 

 

Выбрать опцию «Установка из указанного места» 

Шаг 2 

 

 

Нажать кнопку «Обзор» и указать путь к папке INSTALL 
установочного комплекта 

 

Шаг 3 
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Установка Мастером драйверов в системе. 

Шаг 4 

 

Завершение работы Мастера. 

Шаг 5 

 
В папке INSTALL установочного пакета размещены файлы bulk.dll, bulkn.inf и 

bulkn.sys. Для ручной установки драйверов (не рекомендуется) необходимо в Проводнике 

Windows (Windows Explorer) правым щелчком мыши на файле bulkn.inf вызвать контекстное 

меню и выбрать в нем пункт 'Установить' (Install). Установка возможна только тогда, когда 
файлы bulk.dll и bulkn.sys находятся в одной папке (каталоге) с файлом bulkn.inf. 

1.2 Запуск программы SurfaceScan и выход из нее 

Для упрощения запуска программы SurfaceScan рекомендуется создать на рабочем столе 
управляющего компьютера соответствующий ярлык: в файловом менеджере (Проводнике) 
щелкнуть правой кнопкой на имени SurfaceScan.exe и выбрать пункт контекстного меню 

«Отправить > Рабочий стол (создать ярлык)», в результате чего на рабочем столе появится 
ярлык, например:  

 

 
 

Для запуска программы SurfaceScan, дважды щелкните на ее ярлыке, помещенном на 
рабочем столе управляющего ПК. Программа также может быть запущена из файл-менеджера: 
например, двойным щелчком мыши на файле SurfaceScan.exe в Проводнике Windows.  

 

Рекомендуется запускать программу SurfaceScan после включения блока 
электроники АСМ NT-206 и установления связи между блоком и компьютером (т.е. 
дождаться характерного оповещения операционной системой о подключении 
внешнего устройства). 

Закрытие программы SurfaceScan в Windows возможно несколькими способами – 

нажимая левую кнопку мыши на кнопке  в правом верхнем углу окна программы или выбором 
пункта меню File > Exit.  
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1.3 Главное окно программы SurfaceScan 

После запуска программы SurfaceScan на рабочем столе компьютера отображается 
основное окно программы (Рис. 1.1). По умолчанию окно содержит линейку инструментов и 
меню; все другие панели управления и элементы интерфейса в основном окне активируются 
после выбора соответствующих пунктов меню или при нажатии соответствующих кнопок на 
линейке инструментов. Окна визуализации, отображающие процесс измерения и его 
результаты, отображаются после запуска соответствующих процедур в панели управления, 
меню или при нажатии соответствующих кнопок на линейке инструментов.  

 

Сектор измеренных данных

Общая панель управления

Линейка инструментовСтрока меню

Панель индикаторов

Заголовок основного окна программы Кнопки управления
окном

Строка подсказки
 

Рис. 1.1. Главное окно программы SurfaceScan с активированными общей панелью управления и панелью 
индикаторов. 

Сектор измеренных данных – специально выделенная область в нижней части основного 
окна, в которой в виде эскизов отображаются все АСМ-изображения, полученные в данном 
сеансе работы программы, например:  
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В строке подсказки у нижней границы основного окна интерактивно отображается 
краткое описание функций или кнопок, над которыми в текущий момент находится курсор 
мыши, например: 

 

 


  

1.4 Меню программы SurfaceScan 

Содержание пунктов меню программы SurfaceScan и их общее описание представлено на 
следующей схеме: 

 

File View  Task Service Tools Window Help 
Save  Main Scanning line Reset hardware Video Cam  Tile  About 

Save as Drives Scanning matrix Calibrate SurfaceView Cascade  

Options Laser Two-pass scanning Change scanner  Arrange all  

Exit Feedback  Multilayer scanning    Hide   

 Generator Spectroscopy in point   Show  

 FvsD  
Area  

Dynamic force 
spectroscopy 

    

 Indicator Lithography     
 Container Tribometry line     
 Gain control Drilling     
 Viscosity Spectroscan     

       
Общие операции 
сохранения 
полученных 
данных в 
текущем окне, 
вывод панели 
настроек 
программы, 
выход из 
программы. 

Команды для 
отображения/
отключения 
соответству-
ющих 
панелей 
управления. 

Команды запуска 
измерительных 
процедур. 

Сервисные 
процедуры: 
инициализация 
связи с прибором, 
ввод калиб-
ровочных 
параметров, смена 
сканера. 

Команды 
быстрого 
запуска 
вспомога-
тельных 
приложений. 

Команды 
управления 
окнами в 
основном 
окне. 

Информа-
ция о 
программе 
Surface 
Scan и ее 
текущей 
версии. 

 
Меню File содержит команды общих операций сохранения измеренных данных, 

отображаемых в активном (текущем) окне, вызова панели настроек программы, выхода из 
программы (завершения работы программы). Команды File > Save и File > Save as активируют 
стандартное для операционной системы диалоговое окно сохранения данных в файле, 
например, 
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Список доступных типов файлов (форматов) изменяется в зависимости от типа 
измеренных данных (например, матрица АСМ-изображения, кривая подвода-отвода и др.). По 
умолчанию для АСМ-изображений предлагается использовать формат *.mps, который 

позволяет сохранять в одном файле неограниченное количество наборов (полей, матриц) 
данных (в том числе и разнородных), относящихся к одному измерению, например, 
изображение топографии, карту латеральных сил, данные силовой спектроскопии и др., 
является стандартным внутренним форматом для продуктов ОДО “Микротестмашины”. Другие 
варианты – формат *.spm (2001) (сохраняет до четырех однородных наборов данных); *.spm 

(сохраняет одно поле данных, т.е. одно АСМ-изображение), текстовой формат *.txt, который 

может быть непосредственно открыт любой программе сторонних производителей. Линейные 
данные записываются в текстовом формате *.txt, либо окно с графиком может быть 

сохранено непосредственно в виде растрового изображения формата *.bmp. 

Команда File > Options служит для вывода панели общих настроек программы 
(подробнее см. ниже). Команда File > Exit завершает работу программы.  

 
Меню View содержит команды для отображения/отключения соответствующих панелей 

управления: 
 Main – Общая панель управления. Содержит главную панель управления основными 

состояниями АСМ NT-206 и используется для «пристыковки» к ней других 
активированных панелей управления, переключение между которыми затем 
осуществляется с помощью закладок; 

 Drives – Панель управления двигателями автоматизированной платформы 
перемещения измерительной головки АСМ NT-206 относительно образца; 

 Laser – Панель управления лазером системы детектирования отклонения кантилевера 
зонда: поле графического отображения положения светового луча на активной зоне 
фотодетектора, кнопка включения/отключения лазера, кнопка включения/отключения 
вспомогательного освещения образца, сервисная кнопка временного отключения 
динамического режима. Функционал данной панели в уменьшенном масштабе 
воспроизведен на главной панели управления;  

 Feedback – Панель управления параметрами обратной связи АСМ NT-206; 
 Generator – Панель управления параметрами генератора колебаний зонда, 

использующегося для проведения измерений в динамическом режиме; 
 FvsD – Панель управления процедурой измерения кривой подвода-отвода 

(спектроскопии в точке); 
 Area – Панель управления для определения объекта измерения: задания точки 

измерения спектроскопии и подобных задач, координат линии для задачи 
трибометрии, выбора области поверхности на образце для сканирования (в пределах 
максимально возможной площади сканирования, физически определяемой 
установленным в приборе пьезосканером) и задания параметров матрицы 
сканирования; 

 Indicator – Панель графических индикаторов, отображающих состояние основных 
показателей системы управления АСМ NT-206; 

 Container – Панель (сектор главного окна программы) измеренных данных, в которой 
в виде эскизов отображаются все АСМ-изображения, полученные в данном сеансе 
работы программы; 

 Gain control – Панель Gain для установки аппаратных коэффициентов усиления 
измерительных каналов прибора; 

 Viscosity – Специализированная панель управления процедурой измерения вязкости 
в тонких слоях. 

 
Меню Task содержит команды запуска задач (измерительных процедур) с 

предварительно настроенными в панелях управления параметрами: 
 Scanning line – сканирование по линии, заданной в панели Area/Line, в режиме, 

установленном в панели Main, с текущими настройками обратной связи, 
определенными в панели Feedback; 
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 Scanning matrix – сканирование области, заданной в панели Area/Matrix, в режиме, 
установленном в панели Main, с текущими настройками обратной связи, 
определенными в панели Feedback; 

 Two-pass scanning – двухпроходное сканирование области, заданной в панели 
Area/Matrix, в режиме, установленном в панели Main с учетом специальных 
параметров для данной задачи, с текущими настройками обратной связи, 
определенными в панели Feedback; 

 Multilayer scanning – многопроходное сканирование области, заданной в панели 
Area/Matrix, в режиме, установленном в панели Main с учетом специальных 
параметров для данной задачи – варьирующейся от слоя к слою нагрузке на зонд, с 
текущими иными настройками обратной связи, определенными в панели Feedback; 

 Spectroscopy in point – силовая спектроскопия (измерение кривой подвода-отвода) 
в точке, заданной в панели Area/Point, в статическом режиме при настройках, 
определенных в панели FvsD; 

 Dynamic force spectroscopy – динамическая частотная спектроскопия 
(сканирование частоты колебаний зонда при подводе-отводе к поверхности) в точке, 
заданной в панели Area/Point, в динамическом режиме при настройках, определенных 
в панели FvsD; 

 Lithography – проведение нанолитографии с настройками, задаваемыми в 
специализированной панели Lithograph parameters (отображается при запуске 
процедуры), в области, заданной в панели Area/Matrix; 

 Tribometry line – функция нанотрибометрии – многоцикловое сканирование вдоль 
линии, определенной в панели Area/Line, с параметрами, установленными в панели 
Main, с текущими настройками обратной связи, определенными в панели Feedback; 

 Drilling – функция «наносверления»; 
 Spectroscan – процедура автоматического проведения силовой спектроскопии 

(измерение кривой подвода-отвода) в каждой точке заданной области сканирования. 
 
Меню Service содержит команды выполнения сервисных процедур: 
 Reset hardware – инициализация связи управляющего компьютера с прибором 

(используется в случае обрыва или отсутсвия связи); 
 Calibrate – вызов специализированной панели для ввода калибровочных параметров 

установленного пьезосканера и задания диапазонов величин каналов АЦП прибора; 
 Change scanner – запуск сервисной процедуры смены пьезосканера. 
 
Меню Tools предоставляет оперативный доступ к командам запуска дополнительных 

сервисных приложений: 
 Video Cam – специализированное окно для вывода на экран изображения от 

встроенной видеосистемы прибора; 
 SurfaceView – запуск программы обработки и визуализации АСМ-изображений 

SurfaceView или SurfaceXplorer. 
Примечание. Для корректного запуска сервисных приложений необходимо определить их 

в панели общих настроек программы File > Options / Tools (см. ниже). 
 
Меню Window содержит системные команды управления и организации 

вспомогательными окнами в пределах основного окна программы: Tile, Cascade, Arrange all, 
Hide, Show. 

 
Меню Help содержит команду About – вывод информации о программе SurfaceScan и ее 

текущей версии. 

1.5 Линейка инструментов 

Линейка инструментов, расположенная под строкой меню программы, содержит кнопки, 
предоставляющие быстрый доступ к главным и наиболее часто используемые командам меню.  
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Рис. 1.2. Линейка инструментов программы SurfaceScan. 

Функции кнопок линейки инструментов (слева направо) следующие. 

 
вывод системного диалогового окна сохранения данных (для данных в активном окне 
визуализации). Аналог команды меню File > Save. 

 
отобразить/отключить общую панель, включающую главную панель управления 
основными состояниями АСМ NT-206. Используется для «пристыковки» к ней других 
активированных панелей управления, переключение между которыми затем 
осуществляется с помощью закладок. Аналог команды меню View > Main. 

 
отобразить/отключить панель Drives управления двигателями автоматизированной 
платформы перемещения измерительной головки АСМ NT-206 относительно образца. 
Аналог команды меню View > Drives. 

 
отобразить/отключить панель Laser управления лазером системы детектирования 
отклонения кантилевера зонда. На панели расположены: поле графического 
отображения положения светового луча на активной зоне фотодетектора, кнопка 
включения/отключения лазера, кнопка включения/отключения вспомогательного 
освещения образца, сервисная кнопка временного отключения динамического режима. 
Функционал данной панели в уменьшенном масштабе воспроизведен на главной 
панели управления Main. Аналог команды меню View > Laser. 

 
отобразить/отключить панель Feedback управления параметрами обратной связи АСМ 
NT-206. Аналог команды меню View > Feedback. 

 
отобразить/отключить панель Generator управления параметрами генератора 
колебаний зонда, использующегося для проведения измерений в динамическом 
режиме. Данная кнопка доступна при выборе динамического режима работы АСМ в 
селекторе на линейке инструментов или на главной панели управления. Аналог 
команды меню View > Generator. 

 
отобразить/отключить панель FvsD управления процедурой измерения кривой 
подвода-отвода (спектроскопии в точке). Аналог команды меню View > FvsD. 

 
отобразить/отключить панель Area задания области измерения: задания точки 
измерения спектроскопии и подобных задач, координат линии для задачи трибометрии, 
выбора области поверхности на образце для сканирования (в пределах максимально 
возможной площади сканирования, физически определяемой установленным в приборе 
пьезосканером) и задания параметров матрицы сканирования. Аналог команды меню 
View > Area. 

 
отобразить/отключить панель Indicator – графических индикаторов, отображающих 
состояние основных показателей системы управления АСМ NT-206. Данная панель 
является автономной и не предназначена для пристыковки к основной панели. Аналог 
команды меню View > Indicator. 

 
отобразить/отключить сектор измеренных данных – специально выделенная зона в 
нижней части главного окна программы, в которой в виде эскизов отображаются все 
АСМ-изображения, полученные в данном сеансе работы программы. Аналог команды 
меню View > Container. 

 
отобразить/отключить специализированную панель Viscosity для управления 
процедурой измерения вязкости в тонких слоях. Аналог команды меню View > Viscosity. 

 
запустить специализированную программу для вывода на экран изображения от 
встроенной видеосистемы прибора. Аналог команды меню Tools > Video Cam. 

 
запуск программы обработки и визуализации АСМ-изображений SurfaceView или 
SurfaceXplorer. Аналог команды меню Tools > SurfaceView. 
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инициализация связи управляющего компьютера с прибором (используется в случае 
обрыва или отсутсвия связи). Аналог команды меню Service > Reset hardware. 

 
запуск сканирования области, заданной в панели Area/Matrix, в режиме, 
установленном в панели Main, с текущими настройками обратной связи, 
определенными в панели Feedback. Аналог команды меню Task > Scanning matrix. 

 
запуск процедуры двухпроходного сканирования области, заданной в панели 
Area/Matrix, в режиме, установленном в панели Main с учетом специальных 
параметров для данной задачи, с текущими настройками обратной связи, 
определенными в панели Feedback. Аналог команды меню Task > Two-pass scanning. 

 
запуск процедуры многопроходного сканирования области, заданной в панели 
Area/Matrix, в режиме, установленном в панели Main с учетом специальных 
параметров для данной задачи – количества слоев и варьирующейся от слоя к слою 
нагрузке на зонд, с текущими иными настройками обратной связи, определенными в 
панели Feedback. Аналог команды меню Task > Multilayer scanning. 

 
запуск процедуры силовой спектроскопии (измерение кривой подвода-отвода) в точке, 
заданной в панели Area/Point, в статическом режиме при настройках, определенных в 
панели FvsD. Аналог команды меню Task > Spectroscopy in point. 

 
запуск процедуры динамической частотной спектроскопии (сканирование частоты 
колебаний зонда при подводе-отводе к поверхности) в точке, заданной в панели 
Area/Point, в динамическом режиме при настройках, определенных в панели FvsD. 
Аналог команды меню Task > Dynamic force spectroscopy. 

 
запуск сканирования по линии, заданной в панели Area/Line, в режиме, установленном 
в панели Main, с текущими настройками обратной связи, определенными в панели 
Feedback. Аналог команды меню Task > Scanning line. 

 
запуск процедуры нанолитографии с настройками, задаваемыми в специализированной 
панели Lithograph parameters (отображается при запуске процедуры), в области, 
заданной в панели Area/Matrix. Аналог команды меню Task > Lithography. 

 
запуск процедуры автоматического подвода образца к зонду с предварительно 

установленными настройками. Аналогино кнопке To на главной панели управления (в 
секторе Z-approach > Auto). 

 
запуск автоматического отвода образца от зонда. Аналогино кнопке Off на главной 

панели управления (в секторе Z-approach > Auto). 

 
остановка текущего процесса измерения. 

 
селектор выбора режима работы прибора – динамического или сатического 

( ). 
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2 ПАНЕЛИ УПРАВЛЕНИЯ АСМ NT-206 

Все управление работой АСМ NT-206, а также визуализация получаемых от прибора 
данных и настройка самой программы SurfaceScan реализуются в специализированных панелях, 
которые выводятся на монитор управляющего компьютера и отключаются нажатием 
соответствующих кнопок в линейке инструментов или выбором соответствующих команд меню 
программы. Ниже приведено описание функции панелей. 

2.1 Главная панель управления сканированием 

Главная панель управления сканированием Main (Рис. 2.1) отображается на экране при 

нажатии кнопки  в линейке инструментов или выбором пункта меню View > Main. Главная 
панель Main по умолчанию является основой общей панели управления (собственно 
плавающая панель Control panel), к которой могут быть пристыкованы другие панели.  

 
 

Индикатор выполнения задачи

Заголовок общей панели Кнопка закрытия общей панели 

Закладка с названием панели 

Селектор режима

Блок для установки 
дополнительных параметров 

Селектор задач

Зона ручного 
подвода/отвода 

Блок управления двигателем 
грубого подвода/отвода 

Селектор задержки шагов 

Кнопки 
запуска/ 

остановки 
двигателя 

Зона автоматического 
подвода/отвода 

Кнопки 
запуска/ 

остановки 
двигателя 

Кнопка запуска/остановки 
измерения

Блок управления лазером 

Параметр интенсивности пятна 

Зона настройки лазера  

Точка оптимальной 
настройки лазера  

Кнопка включения лазера  

Кнопка временного переключения 
в статический режим  

Кнопка включения подсветки камеры 

Индикатор интенсивности пятна 

Поле ввода расстояния  

 

Рис. 2.1. Главная панель управления сканированием. 

Панели управления (помимо главной) программы можно пристыковать к общей панели, 
перетаскивая их мышью за полосу заголовка в пределы общей панели. При этом переключение 
между пристыкованными панелями осуществляется щелчком мыши по соответствующей 
закладке в верхней части общей панели. Необходимо учитывать, что пристыкованная панель 
отключается и вновь отображается вместе с общей панелью. Если панель не пристыкована 
(размещена в главном окне программы отдельно), то отключение общей панели не влияет на ее 
состояние. Чтобы отстыковать какую-либо панель управления от общей панели, зафиксируйте 
мышь на закладке с названием необходимой панели и перетащите ее на свободное место в 
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главном окне программы. Отключить отстыкованную панель можно, нажав соответствующую ей 
кнопку на линейке инструментов либо выбрав соответствующую команду в меню View. 

Панель управления сканированием Main, настроенная для работы в статическом и 
динамическом режимах, со всеми другими пристыкованными панелями управления показана на 
Рис. 2.2. 

 

  

Рис. 2.2. Главная панель управления сканированием с другими пристыкованными панелями управления, настроенная 
для сканирования участка в статическом (слева) и динамическом (справа) режимах.  

С помощью панели Main оператору предоставляется возможность устанавливать задачи и 
режимы работы АСМ, управлять включением лазера и отслеживать настройку лазерной системы 
детектирования отклонения консоли АСМ, а также выполнять вертикальный подвод/отвод 
образца относительно зонда. Панель также содержит кнопку для запуска и завершения 
процесса измерения. 

Задачи (Task), реализуемые с помощью АСМ NT-206:  
 Сканирование матрицы (Scanning matrix) – измерение участка поверхности 

(участок определяется в панели Area; 
 Сканирование линии (Scanning line) – измерение профиля поверхности вдоль 

заданной линии (линия задается в панели Area); 
 Двухпроходное сканирование (Two-pass scanning) – специализированная СЗМ-

методика, реализующая сканирование одного участка в два прохода для 
получения сначала изображения топографии, а затем – изображения контраста; 

 Многослойное сканирование (Multilayer scanning) – специализированная методика 
для автоматизированного измерения набора АСМ-изображений одного участка с 
различными значениями нагрузки зонда на поверхность образца (параметра set-
point); 

 Спектроскопия в точке (Spectroscopy in point) – силовая спектроскопия в 
заданной точке в пределах измеряемого участка; 

 Динамическая частотная спектроскопия (Dynamic force spectroscopy) – 
специализированная методика для автоматической регистрации амплитудно-
частотных характеристик колебания зонда при сближении с поверхностью 
образца. Сближение зонда с образцом выполняется ступенчато с регистрацией в 
каждой точке амплитудно-частотной характеристики зонда, работающего в 
динамическом режиме; 

 Литография (Lithography) – специализированная методика воздействия зондом на 
поверхность образца по задаваемой оператором карте (растровой, СЗМ-
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изображению или специальной таблице координат). Предусмотрены три режима 
воздействия – контролируемым изменением нагрузки зонда, неконтролируемым 
вертикальным перемещением пьезотрубки и подачей контролируемого 
электрического потенциала на зонд; 

 Трибометрия вдоль линии (Tribometry line) – специализированная методика 
воздействия зондом на поверхность образца по задаваемой оператором линии 
заданное количество циклов с постоянной нагрузкой зонда на образец; 

 Сканирование спектров (Spectrum scan) – автоматическое измерение спектров 
(проведение силовой спектроскопии для регистрации кривых подвода-отвода) в 
точках матрицы сканирования и сохранение полученного массива данных. 

 «Наносверление» (Drilling) – специализированная процедура, имитирующая 
сверление поверхности в наномасштабе, реализуемая совмещением 
вращательного движения зонда с индентированием им поверхности. 

Атомно-силовой микроскоп NT-206 поддерживают работу в статическом (STATC) и 
динамическом (DYNAMIC) Режимах (Mode) для всех Процедур (Task).  

В зависимости от выбранной Процедуры (Task), поле под селектором Режима (Mode) 
обеспечивает включение дополнительных параметров: 
 при Сканирование матрицы – дополнительной опции регистрации данных при 

обратном проходе сканера Collect backward data, которая позволяет 
регистрировать и отображать данные, полученные системой при обратном ходе 
пьезосканера вдоль линии сканирования, а затем сохранять полученные данные 
в файле данных вместе с данными, полученными при сканировании в прямом 
направлении. Второй дополнительный параметр – использование управляемой 
нагрузки Use load control, что позволяет задать переменную нагрузку при 
измерении, изменяющуюся пропорционально вдоль направления медленного 
сканирования от начальной (устанавливается вручную в поле Start, %) до 
конечной (устанавливается вручную в поле End, %) величины; 

 при Сканирование линии – дополнительной опции регистрации данных при 
обратном проходе сканера Collect backward data (аналогично предыдущему 
пункту); 

 при двухпроходном сканировании – смещения или расстояния подъема перед 
вторым проходом в начале (Start lift, nm) и конце (End lift, nm) области 
сканирования; 

 при Трибометрии – дополнительной опции регистрации данных при обратном 
проходе сканера Collect backward data (аналогично вышеуказанному) и задания 
количества циклов возвратно-поступательного движения сканера вдоль заданной 
линии – # cycles; 

 при Сканировании спектров – дополнительной опции установки регулярности 
измерения спектров (кривых подвода/отвода) в точках матрицы сканирования 
отдельно для двух осей – Measure each ### point on X/Y (Измерять каждую ### 
точку по X/Y).  

 при «Наносверлении» – задания размера квадрата, в пределах которого будет 
осуществляться вращательное движение зонда (Size of square, nm), параметр 
задержки в каждой точке (Delay each pt, ms), а также дополнительные опции, 
определяющие вертикальное смещение зонда относительно поверхности либо 
при их сближении (Approach), либо при отводе (Withdraw) (в последнем случае 
сперва выполняется внедрение зонда в поверхность). 

 
Блок управления лазером системы детектирования отклонения консоли содержит кнопку 

включения лазерного модуля Laser, дополнительные сервисные кнопки:  

 Temp static – временное переключение прибора, работающего в динамическом 

режиме, в статический режим для оценки положения пятна лазерного луча и необходимой 
корректировки настройки фотодетектора. Данная кнопка в статическом режиме АСМ 
недоступна.  

 Camera light – включение подсветки области обзора для видеокамеры встроенной 

видеосистемы. 



Руководство пользователя • Программа SurfaceScan: Панели управления АСМ NT-206 

 17

Кнопка Laser при выполнении наиболее распространенных измерений обычно 

задействуется в первую очередь сразу после запуска программы – для включения лазерного 
модуля (если перед этим дополнительно не требуется выполнить инициализацию связи 
компьютера с блоком электроники АСМ) и, соответственно, активации системы детектирования. 
Отдельные процедуры, тем не менее, могут использовать не штатную систему детектирования, 
поэтому отключение лазера при их проведении оговаривается отдельно. 

Зона настройки лазера графически интерпретирует положение светового пятна, 
отраженного от обратной стороны кантилевера на фотодетектор, и помогает правильно 
отрегулировать измерительную систему. Серый круг над горизонтальной осью отмечает 
оптимальное положение пятна на фотодетекторе при настройке. Положение отраженного 
лазерного пятна передается подвижным кругом, который изменяет цвет в зависимости от 
интенсивности освещения фотодетектора. Белый цвет подвижного круга соответствует самой 
низкой интенсивности освещения фотодетектора; красный цвет – максимальной интенсивности. 
Переходные от белого к красному цвета подвижного круга соответствуют промежуточным 
значениям интенсивности отраженного светового пятна на фотодетекторе. 

Горизонтальный индикатор под зоной настройки лазера показывает интенсивность 
освещения фотодетектора на основе выходного сигнала и может также использоваться при 
регулировке положения фотодетектора. Абсолютное значение интенсивности освещения I в 
цифровом виде (в %) отображается в левом верхнем углу графической зоны настройки лазера.  

Цифровые значения X и Y, отображаемые в правом нижнем углу графической зоны 
предоставляют информацию о положении отраженного пятна на фотодетекторе, где 100% – 
центр оси, 0% – положение на границе поля или вне его.  

Блок управления лазером на панели Main является полнофункциональным уменьшенным 
вариантом специализированной панели Laser, подробное описание которой приведено ниже. 
Использовать панель Laser рекомендуется в случаях, когда необходимо наблюдать за 
состоянием лазерной системы детектирования постоянно или издалека, в то время как блок 
управления лазером на панели Main используется обычно для оперативного контроля и 
наблюдения за настройкой системы детектирования прибора.  

 
Блок Z Approach содержит элементы для управления электродвигателем грубого 

подвода/отвода – вертикальным перемещением образца относительно зонда в ручном (зона 
Manual в верхней части блока) или автоматическом (зона Auto в нижней части блока) режиме. 
Параметр времени задержки шага Drive delay относится ко всем режимам и позволяет управлять 
скоростью подвода/отвода: большее время задержки означает более медленное движение. 
Функции кнопок блока: 

 

 
Запуск отвода поверхности от зонда; 

 
Запуск сближения поверхности и зонда (подвод); 

 

Остановка мотора вертикального перемещения и, соответственно, 
вертикального перемещения. Для остановки можно также использовать 

повторное нажатие на активную кнопку TO или OFF, а также клавишу 

Esc на клавиатуре управляющего ПК. 

В режиме автоподвода Auto сближение зонда и образца будет происходить до тех пор, 
пока зонд не начнёт 'чувствовать' поверхность. После этого кнопка TO автоподвода будет 

заблокирована. Отвод в режиме Auto доступен всегда и по нажатию кнопки OFF платформа с 
образцом будет автоматически отведена от зонда на 10000 шагов* или до тех пор, пока не 

будет нажата кнопка Stop.  
* Примечание. Количество шагов, выполняемое при автоматическом отводе, задается параметром 
WithdrawMaxAutoSteps в блоке [Drives] файла SurfaceScan.ini и устанавливается предприятием-
изготовителем равным 10000. При необходимости данный параметр может быть уменьшен пользователем 
редактированием файла SurfaceScan.ini при закрытой программе SurfaceScan. Увеличивать параметр 
WithdrawMaxAutoSteps не рекомендуется. 

Если после завершения режима Auto необходимо дополнительно приблизить образец к 
зонду, оператор может использовать ручной режим (зона Manual). Система будет выполнять 
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количество шагов, заданное в поле Number of steps. Расстояние, соответствующее количеству 
шагов, отображается в поле Distance (micron). Каждый шаг механизма составляет 0.875 мкм.   

 

Будьте внимательны! В ручном режиме возможно сближение 
образца и зонда без ограничения. Слишком большое количество заданных 
шагов без визуального контроля их исполнения может привести к 
повреждению зонда и измеряемой поверхности! 

Запуск и остановка процесса измерения осуществляется кнопкой START (функция кнопки 

в нажатом состоянии изменяется на обратную – Stop): 

 

Запуск процесса измерения согласно установленной задаче. 
Повторное нажатие активированной кнопки – остановка 
измерения; 

 
Остановка процесса измерения.  

2.2 Панель индикаторов 

Панель Indicator (Рис. 2.3) отображается при нажатии кнопки  в линейке 
инструментов или при выборе команды меню View > Indicator и графически представляет 
оператору состояние наиболее важных параметров измерительной системы. 
 

  

Рис. 2.3. Панель индикаторов в статическом (слева) и динамическом (справа) режимах. 

Отображаемые в панели параметры следующие: 
 Z – относительное вертикальное сжатие/расширение пьезосканера. Полностью 

закрашенное поле ндикатора (100%) означает, что пьезосканер полностью 
расширен (безопасное состояние). Отсутствие показания на индикаторе (0%) 
означает полное сжатие пьезосканера.  

 

Будьте внимательны! Данная ситуация (т.е. 0% на индикаторе Z) 
представляет опасность, т.к. реальное положение зонда относительно 
измеряемой поверхности перестает контролироваться системой, что в конечном 
счете может привести к повреждению зонда и исследуемой поверхности, а 
также пьезосканера. При возникновении подобной ситуации необходимо срочно 
отвести поверхность от зонда (допускается даже без остановки сканирования). 

Оптимальным при контакте зонда с поверхностью считается нейтральное положение 
сканера – т.е. состяние, при котором на индикаторе Z вертикального сжатия/расширения 
показание составляет порядка 50%. Однако в ходе сканирования данный показатель будет 
изменяться в зависимости от конкретного рельефа измеряемой поверхности. 

 Load – текущее значение нагрузки зонда на поверхность образца (в процентах). В 
статическом режиме это соответствует относительному отклонению канитилевера зонда: 
свободное состояние кантилевера, т.е. без контакта с пловерхность соттветствует 0% 
нагрузки, максимальный допустимый изгиба кантилевера и, соответственно, максимальная 
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нагрузка зонда на поверхность – 10%. В динамическом режиме это описывает степень 
подавления амплитуды колебаний кантилевера (отношение текущей амплитуды к амплитуде 
свободных колебаний) (в процентах) – 0% соответствуют амплитуде свободных колебаний, 
100% соответствуют полному подавлению колебаний кантилевера зонда. Графически 
индикатор нагрузки реализован как горизонтальная отметка, указывающая в масштабе 
своего поля уровень, установленный регулятором нагрузки Load на панели Feedback, а 
текущие значения нагрузки отображаются как отклонения от установленного уровня в виде 
цветных столбиков вверх (по умолчанию зеленого цвета) и вниз (по умолчанию красного 
цвета) от данной отметки. Отклонения в общем случае определяются системой АСМ исходя 
из положения пятна лазера на фотодетекторе; 

 Tor (в статическом режиме, от англ. Torsion – кручение) – значение латерального 
отклонения кантилевера зонда АСМ, определенное по соотношению сигналов от левой и 
правой половин фотодетектора. Равновесное состояние кантилевера, то есть отсутствие 
кручения, соответствует 50%; 

 Ph (в динамическом режиме, от англ. Phase) – сдвиг фазы колебаний кантилевера зонда (в 
градусах). Сдвиг между фазой входного сигнала, управляющего колебаниями кантилевера 
зонда, и выходного сигнала, регистрируемого на фотодетекторе. Сдвиг обусловлен 
механическими процессами, происходящими при контакте острия зонда с измеряемой 
поверхностью, и несет дополнительную информацию о локальных свойствах поверхности.  

Обратите внимание, что панель Indicator не предусматривает ее присоединения к общей 
панели управления, поскольку она должна быть постоянно видна для слежения за состоянием 
критически важных параметров прибора и его измерительной системы. Панель имеет два 
режима – полный (когда видны ее рамка и заголовок) и сокращенный (когда рамка и заголовок 
отключены). Переключение между режимами отображения осуществляется двойным щелчком 
левой кнопкой мыши в пределах панели. Полный режим отображения панели позволяет 
осуществлять ее перемещение мышью. 

2.3 Панель управления лазером 

Панель Laser (Рис. 2.4) отображается при нажатии на кнопку  на линейке 
инструментов или выборе пункта меню View > Laser. Панель содержит кнопку для 
включения/выключения лазера, дополнительные кнопки сервисных функций и зону 
графического отображения положения светового луча на активной зоне фотодетектора. 

 

Параметр интенсивности пятна

Зона настройки лазера

Точка оптимальной
настройки лазера

Кнопка включения лазера
Кнопка включения подсветки камеры

Кнопка временного переключения
в статический режим

Координата пятна по вертикальной оси

Координата пятна по горизонтальной оси

Графический индикатор интенсивности
пятна

 

Рис. 2.4. Специализированная панель управления лазером системы детектирования отклонения кантилевера зонда. 
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Полнофункциональным уменьшенным вариантом специализированной панели Laser в 
программе SurfaceScan является блок управления лазером на панели Main. На главной панели 
управления сканированием данные функции продублированы для удобства оперативного 
контроля и наблюдения за системой, однако, если необходимо наблюдать за состоянием 
лазерной системы детектирования постоянно или издалека, рекомендуется воспользоваться 
отстыкованной панелью Laser. 

Кнопка Laser включает/выключает лазер системы детектирования отклонения 

кантилевера зонда.  
Кнопка Camera light включает светодиод, освещающий поле обзора встроенной 

видеокамеры. Это позволяет улучшить качество видеоизображения системы. 

Кнопка Temp.Static позволяет в динамическом режиме временно переключаться в 
статический режим для проверки и регулировки положения фотодетектора.  

Графическая зона Reflected spot position графически интерпретирует сигналы от 
фотодетектора и помогает правильно отрегулировать измерительную систему. Серый круг над 
горизонтальной осью отмечает оптимальное положение пятна на фотодетекторе при настройке. 
Положение отраженного лазерного пятна передается подвижным кругом, который изменяет 
цвет в зависимости от интенсивности освещения фотодетектора. Белый цвет подвижного круга 
соответствует самой низкой интенсивности освещения фотодетектора; красный цвет – 
максимальной интенсивности. Переходные от белого к красному цвета подвижного круга 
соответствуют промежуточным значениям интенсивности отраженного лазерного пятна на 
фотодетекторе. 

Обратите внимание, что низкая интенсивность освещения может быть вызвана 
различными причинами: 
1) Низкая интенсивность светового луча, отраженного от тыльной стороны кантилевера из-за 

ненадлежащей настройки падающего лазерного луча на кантилевер или плохой 
отражающей способности тыльной стороны кантилевера. В этом случае при контрольном 
перемещении фотодетектора (вращением ручек на измерительной головке АСМ NT-206) 
пятно будет перемещаться в пределах графической зоны не изменяя своего цвета 
(интенсивности).  

2) Неправильно отрегулировано положение фотодетектора – отраженное пятно попадает за 
его пределы (Рис. 2.5b). В этом случае дополнительная регулировка положения 
фотодетектора (вращением ручек на измерительной головке АСМ NT-206) переместит круг 
ближе к центру зоны, и его цвет изменится от белого к красному (Рис. 2.5c). 

Когда отраженное пятно не попадает на фотодетектор (или лазер отключен), подвижный 
круг отображается в виде статичного белого контура в самом центре графической зоны (Рис. 
2.5a). Пороговое значение интенсивности освещения, определяющее появление/исчезновение 
круга, может быть изменено редактированием параметра BottomIntensity в секции [Laser] 

файла SurfaceScan.ini.  

Вертикальный индикатор справа от зоны графического отображения положения светового 
пятна показывает интенсивность освещения фотодетектора на основе выходного сигнала и 
может также использоваться при регулировке положения фотодетектора. Абсолютное значение 
интенсивности освещения I в цифровом виде (в %) отображается в левом верхнем углу 
графической зоны панели.  

Цифровые значения X и Y (в %), отображаемые в правом нижнем углу графической зоны 
предоставляют информацию о положении отраженного пятна на фотодетекторе. Эта информация 
позволяет точнее отрегулировать позицию фотодетектора: 100 % означает полное центрирование 
пятна по соответствующей оси (X или Y). Однако при настройке системы детектирования, когда 
зонд не находится в контакте с поверхностью образца, оптимальное положение пятна в 
графической зоне отмечено серым кругом, «лежащим» на горизонтальной оси. Таким образом, при 
настройке положения фотодетектора оптимальные координаты пятна будут X=100%, Y=75% (пятно 
«лежит» сверху на горизонтальной оси по центру, например, как на Рис. 2.5c). 

 

Обратите внимание, что регулирование положения фотодетектора должно 
производиться в статическом режиме работы АСМ, поскольку динамический 
режим не дает правильной информации о положении отраженного светового 
пятна на фотодетекторе. Поэтому, если Вы хотите проверить или 
скорректировать настройку фотодетектора, временно переключитесь в 
статический режим при помощи кнопки Temp. Static в панели Laser (или Main) 



Руководство пользователя • Программа SurfaceScan: Панели управления АСМ NT-206 

 21

 

   
a b c 

Рис. 2.5. Панель управления лазером при различных состояниях системы детектирования: a – отраженное пятно вне 
фотодетектора (координаты 0% – пятно вне чувствительной зоны фотодетектора, интенсивность пятна 0%; пятно 
при этом также может отображаться контуром с положением точно в центре, определяемом общей равномерной 

фоновой засветкой фотодетектора); b – отраженное пятно находится на внешнем краю фотодетектора, 
интенсивность низкая, цвет пятна белый или переходный; c – отраженное пятно вблизи оптимального положения на 
фотодетекторе, интенсивность пятна на фотодетекторе 89% (цвет – ярко красный) (значения интенсивности могут 

изменяться в зависимости от состояния отражающей поверхности кантилевера зонда и настройки системы 
детектирования). 

2.4 Панель настройки параметров генератора 
(при работе в динамическом режиме) 

Панель Generator (Генератор) (Рис. 2.6) доступна в динамическом режиме и 

отображается при нажатии кнопки  на линейке инструментов или при выборе пункта меню 
View > Generator.  

 

Режим работы генератора

Настройки генератора

Строка цифровых полей ввода

Параметры автогенераторной системы

Переключатель ослабления
управляющего напряжения генератора

Регулятор амплитуды колебаний

Регулятор частоты колебаний

Регулятор фазы колебаний

Установка левой границы регулируемой зоны

Установка правой границы регулируемой зоны

Кнопка вызова панели
сканирования АЧХ

Включение режима работы с
камертонным осциллятором

 

Рис. 2.6. Панель Generator для настройки параметров генератора. 
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Селектор Detector устанавливает режим работы детектора колебаний зонда. В режиме 
синхронного детектора (Synchronous) система отслеживает и поддерживает заданную частоту 
колебаний. В режиме амплитудного детектора (Amplitude) система отслеживает и поддерживает 
заданную амплитуду колебаний кантилевера зонда. Режим селектора по умолчанию – 
Synchronous, который рекомендуется для большой части приложений. 

Зона Autogenerator settings содержит регуляторы, необходимые для настройки параметров 
автогенераторной системы. Параметры Phase, °, Left bound, Hz and Right bound, Hz 
устанавливают соответствующие параметры фазы, левой и правой границы контролируемой 
зоны смещения резонансного пика для системы управления. Эта опция доступна, когда в 
приборе установлен самодетектирующийся пьезоэлектрический кантилевер.  

 

Обратите внимание, что точная настройка положения регуляторов возможна 
также клавишами "вверх" и "вниз" на клавиатуре управляющего ПК, когда 
необходимый регулятор активирован мышью. Альтернативно можно установить 
точное значение параметров, вводя величины (в десятичном виде) в поле ввода 
над соответствующим регулятором. Цифровое поле ввода повторяет значение 
параметра, установленное соответветствующим регулятором. Эти принципы 
установки параметров распространяются на всю программу SurfaceScan. 

Переключатель Reduct, dB используется для ослабления в 10 раз (20 dB) амплитуды 
напряжения, управляющего пьезоактиватором, в случае, когда ее величина не может быть 
точно настроена регулятором Amplitude range, mV. Этот переключатель действует для всех 
режимов, использующих генератор колебаний.  

Зона Settings содержит регуляторы для настройки параметров генератора. Регулятор 
Amplitude range, mV устанавливает амплитуду напряжения возбуждения пьезоактиватора и, 
следовательно, амплитуду свободных колебаний кантилевера. Регулятор Frequency, Hz 
устанавливает частоту управляющего сигнала пьезоактиватора. Частота должна 
соответствовать резонансной частоте кантилевера. В этом случае измерительная система имеет 
максимальную чувствительность. Для установки резонансной частоты кантилевера необходим 
запуск функции сканирования частоты – панели Frequency Sweep.  

Кнопка Tuning fork активирует специализированный режим для работы с камертонным 
осциллятором вместо штатной системы детектирования для реализации shear-force измерений. 
Работа прибора в данном режиме требует, соответственно, предварительной установки 
специализированного держателя с камертонным осциллятором. 

Кнопка Get Frequency Sweep активирует специальную панель Frequency Sweep (Рис. 
2.7), используемую для сканирования частотного отклика кантилевера на приложенное 
механическое возбуждение (практически – для снятия амплитудно-частотной характеристики 
колебаний кантилевера зонда). Полученная кривая используется для выбора рабочей 
резонансной частоты кантилевера. Кнопка Start запускает сканирование частотного диапазона, 

кнопка Stop служит для завершения сканирования. 
 

 

Рис. 2.7. Панель Frequency Sweep для сканирования амплитуды колебаний кантилевера (снятия АЧХ). 
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Таблица в нижнем левом углу панели позволяет задавать: 
 начальное и конечное значения сканируемого частотного диапазона (поля Start (Hz) и 

Stop (Hz) соответственно); 
 количество точек на получаемом графике (# of points); 
 шаг между точками (Step (Hz)), который рассчитывается исходя из ширины диапазона 

и количества измеряемых точек; 
 коэффициента Kf, который используется для преобразования аппаратной частоты 

(устанавливается изготовителем микроскопа для данной системы) и служит для 
корректного отображения частоты колебаний в стандартных единицах (Гц). 

Регулятор, расположенный ниже графической области окна – курсор, служащий для 
установки текущей (рабочей) частоты. Его функция дублируется регулятором Frequency в 
панели Generator. Обратите внимание, что движение регулятора Frequency в панели 
Generator не влияет на положение курсора в панели Frequency Sweep. В левом верхнем углу 
графической зоны панели отображается дополнительная информация:  

 текущее значение частоты, установленное курсором на графике (Cursor position at:); 
 значение частоты генератора в панели Generator (Generator frequency:); текущее 

значение амплитуды сигнала кантилевера, соответствующее частоте генератора 
(Generator amplitude:); 

 добротность для текущей частоты генератора (Q-factor). 
Добротность рассчитывается как  

Q = f0/f. 
Значения частот f0, и f определяются исходя из схемы на Рис. 2.8. 
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Рис. 2.8. Схема определения параметров для расчета добротности (Q-factor). 

Регулятор Range limit служит для быстрой установки пределов сканируемого частотного 
диапазона расширением его границ слева и справа, начиная с текущей позиции курсора. Кнопка 

 Max Range устанавливает максимальную область для сканируемой частоты (смещает точку 

начала в 0, а конечную точку к максимальному значению, то есть 400 кГц). Кнопка отмены  
восстанавливает ранее установленную частоту сканирования и ранее полученный график.  

Опция Legend включает/отключает отображение обозначений, используемых на графике, 
например, 

 
В соответствии с ними, красной линией обозначается кривая Амплитудной характеристики, 
зеленой линией обозначается кривая фазы.  

Опция HW (Hardware) предусмтривает возможность использования аппаратной функции 
сканирования АЧХ (если данная функция предусмотрена в данной аппаратной реализации 
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прибора), что значительно повышает скорость получения искомой кривой. В любом случае 
программное сканирование АЧХ доступно при отключенной опции HW. 

Кнопка  позволяет сохранять текущий график в файле. График может быть сохранен 
как растровое изображение формата BMP или как набор данных в текстовом формате. 

2.5 Панель установки параметров обратной связи 

Панель Feedback (Рис. 2.9) предназначена для установки параметров обратной связи и 

отображается при нажатии кнопки  в линейке инструментов или при выборе пункта меню 
View > Feedback. Панель разделена на три блока – блок общих установок обратной связи 
Feedback settings в верхней части панели, блок настроек ПИД-регулятора PID Regulators в 
средней части и графический блок настройки параметра нагрузки в нижней части панели. 

 
Блок общих настроек Строка цифровых

полей ввода

Строка цифровых
полей ввода

Число измерений
сигнала ошибки в
каждом цикле

Число циклов
обработки
сигнала ошибки в
каждой точке

Кривая подвода

Маркер

Напряжение
смещения на
зонде

Графический блок
настройки нагрузки

Блок ПИД-регулятора

Задержка в точке

Число итераций

Обнуление

Задаваемая нагрузка
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коэффициент

Интегральный
коэффициент

Дифференциальный
коэффициент

Регулятор
положения маркера  

Рис. 2.9. Панель установки параметров обратной связи в исходном состоянии (слева) и после получения кривой 
зависимости силы от расстояния (справа). 

Регулятор FB Delay устанавливает время задержки между обработкой двух поочередных 
управляющих импульсов измерительной системы. Чем больше время задержки, тем меньше 
скорость реакции обратной связи. Как правило, для статического режима данный параметр 
устанавливается в пределах 2…3, для динамического режима – 3…5. Однако оптимальную 
величину задержки необходимо подбирать исходя из конкретных условий сканирования. 

Регулятор Z trace steps определяет дискретизацию системы обратной связи при ее 
реакции на изменения в выходном сигнале (с датчика), т.е. задает системе число итераций, 
используемых для определения компенсации поступившего сигнала ошибки. Большее значение 
Z trace steps позволяет системе обратной связи более точно реагировать на изменения 
положения зонда в процессе измерений, но одновременно замедляет время реакции и, 
соответственно, скорость работы всей системы. В подавляющем большинстве случаев для не 
абсолютно гладкой поверхности образца параметр Z trace steps устанавливается в пределах 
62…63. 

Регулятор Load (нагрузка) устанавливает разрешенный уровень отклонения кантилевера 
при измерении. Этот параметр также иногда называется ”set-point” или опорным уровнем. 
Значение 0% соответствует свободному состоянию кантилевера, 100% соответствует 
максимально допустимому отклонению кантилевера от его нейтрального положения в 
статическом режиме или максимальному уровеню подавления амплитуды свободных колебаний 
кантилевера в динамическим режиме. В физическом смысле регулятор Load задает нагрузку, 
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оказываемую зондом на сканируемую поверхность, величину которой измерительная система 
будет поддерживать постоянной в ходе измерения (за исключением специальных режимов со 
специально изменяемым уровнем нагрузки). 

Кнопка >0< слева от регулятора Load (нагрузка) обнуляет текущий уровень сигнала об 

отклонении кантилевера – фактически сообщает системе об использовании текущего уровня в 
качестве исходного (нуля) для последующей работы. Рекомендуется проводить обнуление 
непосредственно перед заданием рабочего уровня нагрузки и последующим подводом образца к 
зонду.  

Регулятор Tip voltage устанавливает напряжение смещения, прикладываемое между 
зондом и образцом для измерения электростатических сил при реализации двухпроходного 
сканирования и сходных методик. Диапазон изменения напряжения смещения – от –10 В до +10 
В относительно заземленного образца (т.е. в случае подачи на образец нулевого потенциала). 
Эта функция доступна, когда аппаратная часть прибора оснащена дополнительной опцией для 
измерения электростатических сил. 

Регуляторы Proportional gain, Integral gain, Differential gain (в блоке PID Regulators) 
устанавливают для системы обратной связи, соответственно, пропорциональный, интегральный 
и дифференциальный коэффициенты усиления (ПИД-регулятор). Общий коэффициент усиления 
системы обратной связи является суммой всех этих трех компонентов, взятых в пропорциях 
согласно установленным значениям. Параметр Cycles (циклы) задает количество циклов 
обработки сигнала ошибки системы в каждой точке измерений матрицы сканирования. 
Параметр Meas/pnt (Measurements per point – Измерения в точке) задает количество замеров 
сигнала ошибки системы в каждом цикле обработки ПИД-регулятора. 

 
Пропорциональный коэффициент усиления (Proportional gain) обеспечивает 

непосредственную реакцию системы на возникновение сигнала ошибки, с тем чтобы вернуть 
отслеживаемый параметр в заданное состояние. Пропорциональная составляющая тем больше, 
чем больше сигнал ошибки (отклонение от заданного состояния). В случае АСМ, сигнал ошибки 
– это отклонение кантилевера зонда от заданного (заданное отклонение кантилевера 
относительно нейтрального состояния определяется параметром Load), а регулируемый 
параметр – удлинение пьезотрубки (пьезосканера). Следует учесть, что при использовании в 
системе обратной связи только пропорционального компонента регулируемый параметр никогда 
не стабилизируется на заданном значении в силу необходимости т.н. статической ошибки, 
поддерживающей работу регулятора. Чем больше пропорциональный коэффициент усиления, 
тем меньше статическая ошибка, однако при слишком большом пропорциональном 
коэффициенте усиления в системе могут возникнуть автоколебания, а при дальнейшем 
повышении коэффициента система может потерять устойчивость. В приложении к АСМ 
пропорциональный коэффициент усиления отвечает за реакцию системы на локальные 
изменения – на изменение высоты на сканируемом рельефе в текущей точке по сравнению с 
высотой предыдущей точки. 

 
Интегральный коэффициент усиления (Integral gain) определяет вклад общей тенденции 

изменения отслеживаемого параметра в «предсказание» величины реакции системы. В общем 
случае интегральный компонент системы регулирования служит для устранения статической 
ошибки и позволяет системе «учиться», используя предшествующие данные. Например, если 
сигнал ошибки постоянен, то спустя некоторое время регулируемый параметр стабилизируется 
на заданном значении, причем, заданная величина отслеживаемого параметра будет 
поддерживаться работой интегральной цепи системы обратной связи, в то время как 
пропорциональный компонент реакции системы будет равен нулю. Интегральное усиление 
сглаживает локальные отклонения сигнала и «плавание» сигнала, вызванное 
пропорциональной реакцией системы, сужая диапазон колебания сигнала ошибки вокруг 
заданного значения поддерживаемого параметра. В приложении к АСМ интегральный 
коэффициент усиления определяет учет, например, общего наклона линии сканируемого 
рельефа (профиля) в формировании ответной реакции системы на изменение высоты в текущей 
точке по сравнению с предыдущей. Тем не менее, следует учитывать, что слишком болшой 
интегральный коэффициент усиления, будучи достаточно чувствительным, может привести к 
«перепрыгиванию» отслеживаемого параметра через заданную величину, в связи с чем 
регулировать его необходимо с осторожностью. 
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Дифференциальный коэффициент усиления (Differential gain, иногда его также называют 

«предсказательный») отвечает за противодействие системы предполагаемым отклонениям 
регулируемого параметра. Эти отклонения могут быть вызваны внешними возмущениями или 
запаздыванием воздействия регулятора на систему. Чем быстрее регулируемый параметр 
отклоняется от заданной величины, тем сильнее противодействие, создаваемое 
дифференциальной компонентой реакции обратной связи. Иными словами, роль 
дифференциального коэффициента усиления – способствовать удержанию регулируемого 
параметра в определенной зоне значений, с тем чтобы пропорциональный и интегральный 
коэффициенты тщательнее отработали свои задачи и поддержали регулируемый параметр как 
можно ближе к его заданной величине. Применительно к измерениям с помощью АСМ это все 
означает, что наилучшее воздействие на общую реакцию обратной связи дифференциальный 
коэффициент окажет в случае сканирования регулярного микрорельефа, когда предсказать 
разброс высот достаточно легко. В такой ситуации дифференциальный коэффициент может 
быть задан как можно больше. С другой стороны, если сканиуремый микрорельеф грубый и 
непериодичный, дифференциальный коэффициент усиления, пытающийся «предсказать» 
нерегулярные подъемы и спуски, может затруднить работу системы обратной связи. В этом 
случае (а такая ситуация при АСМ-измерениях наиболее вероятна) дифференциальный 
коэффициент усиления предпочтительно минимизировать или вообще отключить.  

 
Графическая зона в нижней части панели Feedback используется для отображения 

кривой зависимости силы взаимодействия между острием зонда и поврехностью образца как 
функции расстояния между ними (т.н. кривая «сила–расстояние», Force-vs-Distance), если эта 
кривая была предварительно измерена в панели FvsD или получена с помощью силовой 
спектроскопии (см. ниже). По умолчанию в этой области отображена надпись «None». Если 
кривая зависимости «сила–расстояние» измерена и отображена в графической зоне окна, под 
ней активизируется регулятор, позволяющий визуально установить оптимальную величину 
параметра Load для проведения последующего сканирования. В частности, как показано на Рис. 
2.9 (справа), обычно оптимальной величиной параметра Load является то, при котором курсор 
регулятора расположен посередине наклонного участка кривой «сила–расстояние». 

2.6 Панель силовой спектроскопии (панель FvsD) 

Панель FvsD (Рис. 2.10) используется для настройки параметров системы при проведении 

спектроскопических измерений. Панель может быть активизирована нажатием кнопки  в 
линейке инструментов или выбором пункта меню View > FvsD.  

Зависимость «сила–расстояние» может быть измерена двумя способами в зависимости от 
выбора контролируемого параметра в селекторе Controlled parameter. При установке Set-point в 
качестве контролируемого параметра, система перемещает образец к зонду, ориентируясь по 
значению параметра Set-point, с равными шагами между его предыдущим и последующим 
значениями в предварительно установленном диапазоне. По результатм измерений строится 
зависимость отклонения кантилевера от параметра Set-point. Отклонение кантилевера  может 
быть непосредственно пересчитано в силу F, если известна изгибная жесткость k используемого 
кантилевера: F=k. 

При установке Distance в качестве контролируемого параметра, система перемещает 
образец к зонду, ориентируясь по расстоянию между образцом и фиксированным положением 
острия зонда (т.е. положением острия зонда в свободном состоянии, считая, что кантилевер 
является неизгибаемым). Образец постепенно сближается с зондом через равные расстояния в 
пределах предварительно установленного диапазона за счет вертикального движения 
(расширения и затем сжатия) пьезосканера с равными шагами. По результатам измерений 
строится зависимость отклонения кантилевера от параметра расстояния (Z-положения зонда).  
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Рис. 2.10. Панель FvsD настройки параметров и управления измерением кривой «Сила–Расстояние». 

Таблица параметров позволяет устанавливать верхнюю границу диапазона движения 
пьезосканера (Top), его нижнюю границу (Bottom), число точек измерений на кривой (Points), 
количество измерений в каждой точке (Measurement), задержку перед проведением измерений 
после каждого выполненного шага в мс (Delay per point, ms), задержку в последней точке 
подвода в мс (Delay last point, ms). Дополнительно имеется возможность установить параметр 
напряжения смещения на сканере Bias Z volt, позволяющий при корректном подборе значения 
совместить точки окончания внедрения и начала отвода на кривой. Для удобства доступа и 
оперативного изменения в таблице также представлен параметр жесткости консоли 
(кантилевера) – Spring costant, который повторяет аналогичное значение, устанавливаемое в 
панели калибровки. 

При выборе Set-point в качестве контролируемого параметра единицы измерения для 
границ рабочего диапазона по вертикальной оси представлены в процентах либо относительно 
амплитуды свободных колебаний кантилевера (в динамическом режиме), либо относительно 
свободного состояния кантилевера без изгиба (в статическом режиме). При выборе расстояния 
как контролируемого параметра значения для верхней и нижней границ рабочего диапазона 
вертикального движения Z-секции сканера выражаются в нанометрах, с учетом того, что весь 
диапазон сжатия/растяжения Z-секции сканера соответствует полной шкале.  

Непосредственно над таблицей параметров расположен селектор, с помощью которого 
можно присвоить имя текущему набору настроек и сохранить их (команда селектора < Add new 
>), например:  

 

    
 

загрузить готовый набор настроек из списка ранее сохраненных (пункты списка без скобок < 
>), удалить выбранный набор из списка (команда селектора < Delete current >). 

Вертикальная шкала с регуляторами Z Distance (при режиме Deflection) / Load (при 
режиме Set-point) в левой части панели графически представляет положение верхней и нижней 
границ рабочего диапазона вертикального движения пьезосканера относительно его полного 
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размаха. Регуляторы предназначены для ручной интерактивной установки, соответственно, 
верхней и нижней границ рабочего диапазона перемещения пьезосканера при проведении 
спектроскопии. При необходимости «связать» обе границы с тем, чтобы при перемещении 
одной границы совместно передвигать и вторую границу, не изменяя диапазона, рекомендуется 
активировать опцию Coupled (сцепить), расположенную под вертикальнй шкалой. 

Кнопки Store и Restore в зоне Range storage используются, соответственно, для 
запоминания текущего положения регуляторов (диапазона) и восстановления их положения (в 
относительных координатах вертикальной шкалы). 

В панели FvsD также находятся кнопки запуска (Get curve) и остановки (Stop) 
упрощенной процедуры статической силовой спектроскопии. Измеренные данные (кривая 
«сила–расстояние») в упрощенном виде выводятся в графической зоне этой панели и панели 
Feedback. 

Для проведения силовой спектроскопии в расширенном варианте, в т.ч. с возможностью 
выбора режима измерений – статического или динамического – необходимо воспользоваться 

кнопками на линейке инструментов  (статическая силовая спектроскопия) и  
(динамическая частотная спектроскопия) или соответствующими командами меню Task > 
Spectroscopy in point или Task > Dynamic force spectroscopy. Также предусмотрена возможность 
запуска спектроскопии из панели Main, установив предварительно в ее селекторе Task задачу 
Spectroscopy in point, а в селекторе Mode режим STATIC или DYNAMIC. 

2.6.1 Статическая силовая спектроскопия 

Функция статической силовой спектроскопии в расширенном варианте запускается командой 

меню Task > Spectroscopy in point или нажатием кнопки  в линейке инструментов. Также эту 
функцию можно запустить из панели Main, установив в ее селекторе Task задачу Spectroscopy in 
point, а в селекторе Mode режим STATIC или DYNAMIC. После запуска функции активируется окно 
визуализации измеренных данных View spectroscopy data (Рис. 2.11).  

 

 

Рис. 2.11. Окно визуализации данных статической силовой спектроскопии. 

Точка в пределах области сканирования, где будут производиться спектроскопические 
измерения, определяется в панели Area (в режиме Point). 

Как указывалось выше, специальные настройки данной функции производятся в панели 
FvsD. Включенная опция Show selected range внизу окна визуализации отображает в поле 
графика вертикальные линии, соответствующие нижней и верхней границам движения 
пьезосканера, установленные в панели FvsD.  
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2.6.2 Динамическая частотная спектроскопия 

Динамическая частотная спектроскопия (Dynamic force spectroscopy) – другой тип 
спектроскопии, реализуемый с помощью АСМ NT-206. Динамическая частотная спектроскопия 

запускается нажатием кнопки  или командой меню Task > Dynamic force spectroscopy. После 
запуска будет выведена вспомогательная панель AFD parameters (Рис. 2.12), в которой необходимо 
задать способ перемещения зонда относительно поверхности образца – с помощью пьезосканера при 
его вертикальном сжатии/растяжении (режим Piezotube controlling, Рис. 2.12 слева) или с помощью 
шагового двигателя и механизма подвода (режим Drive controlling, Рис. 2.12 справа). 

 

         

Рис. 2.12. Панель настроек для динамической силовой спектроскопии при осуществлении вертикального движения с 
помощью пьезосканера (слева) и шагового двигателя механизма подвода (справа). 

В режиме вертикального движения с помощью пьезосканера (Piezotube controlling) 
устанавливаются следующие параметры: 

 Distance 1 – начальная точка рабочего диапазона; 
 Distance 2 – конечная точка рабочего диапазона; 
 Number of points – количество точек измерения в рабочем 

диапазоне; 
 Full length – информация о длине рабочего диапазона. 

В режиме вертикального движения с помощью шагового двигателя механизма подвода 
Drive controlling, вводятся следующие параметры:  

 Number of points – количество точек измерения в рабочем 
диапазоне; 

 Drive step – количество элементарных шагов, которые двигатель 
должен произвести между точками измерений; 

 Full length – информация о длине рабочего диапазона; 
 Direction – направление вертикального движения механизма 

подвода, при котором будет измеряться характеристика Амплитуда–
Частота–Расстояние – либо только при сближении зонда и образца 

, либо только при их отводе  (оба варианта – во 
избежание влияния люфта). 

После установки необходимых параметров в панели AFD parameters непосредственно 
процесс измерения запускается нажатием кнопки  OK  в нижней части панели. В окне 

визуализации измеряемых данных функции AFD («Амплитуда–Частота–Расстояние») будут 
отображаться два двухмерных изображения (Рис. 2.13): 

слева (AFD) – амплитуда колебаний кантилевера (соответствует вертикальной оси и 
определяется цветовой шкалой) как функция частоты колебаний (ось X / по 
горизонтали) и расстояния Distance между поверхностью образца и зондом (ось Y / по 
вертикали); 

справа (PhFD) – сдвиг фазы колебаний кантилевера (соответствует вертикальной оси и 
определяется цветовой шкалой) как функция частоты колебаний (ось X / по 
горизонтали) и расстояния Distance между поверхностью образца и зондом (ось Y / по 
вертикали). 
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Вертикальная шкала справа от зоны двухмерных изображений графически отображает 
движение зонда относительно установленного рабочего диапазона. 

В нижней половине окна визуализации система выводит кривую зависимости амплитуды 
колебаний кантилевера от частоты, полученную при последнем сканировании частотного диапазона 
(соответственно, на предшествующем текущему шаге по вертикали между образцом и зондом). 

 

 

Рис. 2.13. Окно визуализации AFD-анализа – характеристики «амплитуда–частота– расстояние» (визуализация 
данных динамической силовой спектроскопии). 

Строка состояния внизу окна показывает текущую резонансную частоту (FR), амплитуду в 
резонансной точке (AR) и объем выполнения текущей процедуры измерения. 

2.7 Панель настройки параметров области сканирования 

Панель Area (Рис. 2.14) позволяет задавать параметры поля сканирования и 

активизируется нажатием кнопки  в линейке инструментов или выбором пункта меню View > 
Area.  

Панель имеет три режима: Point, Line и Matrix. В режиме Matrix настраиваются общие 
параметры движения пьезосканера. Режим Point предназначен для задания точки, в которой 
будут измеряться характеристика «сила–расстояние» (функция Spectroscopy in point). Режим 
Line позволяет оператору определить участок прямой линии, вдоль которой будет 
производиться измерение единичного профиля поверхности образца при выполнении задачи 
сканирования линии (Scanning line) либо совершаться циклическое движение зонда 
относительно образца при линейной трибометрии (Tribometry line). Графическая зона панели 
служит для задания области (или линии) сканирования (или точки измерения) вручную с 
визуальным контролем объекта, для чего в эту зону предварительно загружается ранее 
полученное АСМ-изображение. Загрузка АСМ-изображения в графическую зону осуществляется 

нажатием кнопки  в окне визуализации необходимого АСМ-изображения. 
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 a b c 

Рис. 2.14. Панель настройки параметров поля сканирования и в режиме: a – задания точки измерений Point; b – 
задания линии сканирования Line; c – задания области и общих параметров сканирования Matrix  

Таким образом, графическая зона панели в режиме Matrix, используется для выделения 
участка на поверхности в пределах полного поля сканирования, где будут проводиться 
последующие измерения (до следующей смены положения или размера участка). Выделение 
необходимого участка в пределах полного поля производятся мышью при нажатой левой кнопке 
либо перетаскиванием мышью границ участка. Перемещение уже отмеченного участка в 
пределах исходного поля производится перетаскиванием рамки выделения мышью при нажатой 
правой кнопке.  

Кнопки справа от графической зоны (АСМ-изображения) служат для: 

 
быстрой установки максимального размера поля сканирования (размер, 
определяемый характеристикой пьезосканера; см. параметры калибровки); 

 
увеличения выделенного участка до заполнения им всей графической зоны (т.н. 
«наезд»); 

 
отмены действия; функция позволяет вернуть состояние графической зоны на 
две операции назад; 

 повтора – функция восстановление отмененных операций 

 
Таблица параметров в режиме Matrix, позволяет установить следующие параметры: 

Num points X число точек матрицы измерений в 
направлении X; 

Left border координата (в битах) левой 
границы участка сканирования 
относительно крайней левой 
стороны максимального поля 
сканирования; 

Num points Y число точек матрицы измерений в 
направлении Y; 

Top border координата (в битах) нижней 
границы участка сканирования 
относительно крайней нижней 
стороны максимального поля 
сканирования; 

Step, nm длина шага между двумя соседними 
точками измерения в матрице 
сканирования. Длина шага зависит 
от размера сканируемого участка и 
числа точек. Если Вы введете в этой 
области необходимое число, размер 
участка сканирования будет 
пересчитан с учетом установленного 
количества точек в матрице 
сканирования и длины шага; 

Right border координата (в битах) правой 
границы участка сканирования 
относительно крайней правой 
стороны максимального поля 
сканирования; 
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Run-in, lines  Параметр «приработки» – 
определяет количество начальных 
линий в матрице сканирования, 
которые будут автоматически 
отсканированы без регистрации 
результата для «разогрева» 
сканирующего устройства, и затем 
промерены снова с регистрацией. 
Позволяет уменьшить нелинейность 
движения пьезосканера в начале 
участка сканирования, вызванную 
его ползучестью; 

Bottom border координата (в битах) нижней 
границы участка сканирования 
относительно крайней нижней 
стороны максимального поля 
сканирования; 

Delay, mks время задержки (в микросекундах) 
перед измерением в текущей точке 
– позволяет подстраивать скорость 
сканирования; 

Width, nm ширина выделенного участка 
сканирования. Рассчитывается 
с учетом границ выделенного 
участка сканирования и длины 
шага; 

Pattern схема сканирования – 
устанавливает направление 
быстрого сканирования и 
начальную точку. См. разъяснения 
ниже; 

Height, nm высота выделенного участка 
сканирования. Рассчитывается 
с учетом границ выделенного 
участка сканирования и длины 
шага; 

 
Параметр Pattern позволяет устанавливать одну из следующих схем сканирования: 
 

 быстрое сканирование по направлению оси X, начиная с верхнего левого угла; 

 быстрое сканирование по направлению оси Y, начиная с верхнего левого угла; 

 быстрое сканирование по направлению оси X, начиная с верхнего правого угла 

 быстрое сканирование по направлению оси Y, начиная с верхнего правого угла 

 быстрое сканирование по направлению оси X, начиная с нижнего правого угла 

 быстрое сканирование по направлению оси Y, начиная с нижнего правого угла 

 быстрое сканирование по направлению оси X, начиная с нижнего левого угла 

 быстрое сканирование по направлению оси Y, начиная с нижнего левого угла. 

 
Режим задания точки Point позволяет устанавливать координаты точки, где будет 

проводиться измерения, к примеру, силовая спектроскопия (снятие характеристики «сила–
расстояние»). Координаты точки измерений X position и Y position устанавливаются в битах 
относительно верхнего левого угла максимального поля сканирования. Допускается также 
графическое задание точки измерений указанием интересующей точки в пределах графической 
зоны курсором, завершаемым одним щелчком левой кнопки мыши. После указания (задания) 
новой точки измерений необходимо переместить сканер в эту новую точку путем нажатия 
кнопки Set position под таблицей координат на панели. 

Режим задания линии Line позволяет определить участок прямой линии, вдоль которой 
будет производиться измерение единичного профиля поверхности образца при выполнении 
задачи сканирования линии (Scanning line) либо совершаться циклическое движение зонда 
относительно образца при линейной трибометрии (Tribometry line). В пределах графической 
зоны предусмотрена возможность задания линии сканирования растягиванием отрезка в 
интересующем месте при нажатой левой кнопке мыши. Таблица под графической зоной 
содержит следующие параметры, которые можно изменять (устанавливать) вручную: 

 

Number points число точек измерений на 
заданном участке прямой линии; 

1st point X координата X (в битах) 
начальной точки отрезка 
сканирования относительно 
крайней левой границы 
максимального поля 
сканирования; 
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Step длина шага между двумя соседними 
точками измерения в сканируемой 
линии; 

1st point Y координата Y (в битах) 
начальной точки отрезка 
сканирования относительно 
крайней нижней границы 
максимального поля 
сканирования; 

Measurement число измерений в одной точке, 
которые затем будут усредняться 
для получения статистически ; 

2nd point X координата X (в битах) 
конечной точки отрезка 
сканирования относительно 
крайней левой границы 
максимального поля 
сканирования; 

Delay, mks время задержки (в микросекундах) 
перед измерением в текущей точке 
– позволяет подстраивать скорость 
сканирования; 

2nd point Y координата Y (в битах) 
конечной точки отрезка 
сканирования относительно 
крайней нижней границы 
максимального поля 
сканирования; 

2.8 Панель управления шаговыми двигателями платформы 
позиционирования 

Панель Drives (рис. 2.15) управляет грубым позиционированием измерительной головки 
относительно образца в горизонтальной плоскости для установки зонда над необходимой 

областью. Панель может быть активирована нажатием кнопки  в линейке инструментов или 
выбором пункта меню View > Drives. 

 

 

Рис. 2.15. Панель управления шаговыми двигателями платформы позиционирования измерительной головки. 

Управление шаговыми двигателями осуществляется следующими кнопками: 

   
запуск перемещения вдоль оси X; 

   
запуск перемещения вдоль оси Y; 

 
остановка включенного шагового двигателя. 
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Визуально, стрелки пусковых кнопок соответствуют направлениям движения предметного 
столика, если смотреть на прибор сверху.  

Одновременно возможна работа только одного двигателя в одном направлении. Когда 
система готова к запуску сканирования, и зонд находится в контакте с поверхностью 
(“чувствует” поверхность), или идет сканирование, кнопки управления моторами 
позиционирования заблокированы. 

С помощью опции Auto активизируется автоматический режим работы шаговых 
двигателей. В автоматическом режиме шаговые двигатели выполняют команды без ограничения 
диапазона перемещения. Остановка двигателей в режиме Auto осуществляется оператором 

нажатием кнопки  в панели или клавиши ESC или другой на клавиатуре управляющего PC 
(за исключением пробела и клавиши ENTER). В ручном (Manual) режиме (при отключенной 
опции Auto) система выполнит предварительно установленное количество шагов в необходимом 
направлении. Один шаг шагового двигателя соответствует линейному перемещению платформы 
на 2.5 мкм. Количество шагов устанавливается в поле Number of steps. Соответствующее 
расстояние рассчитывается и выводится в поле Length (m).  

Поле Drive delay устанавливает время задержки (в миллисекундах) перед каждым шагом 
двигателя. Этот параметр может быть использован для варьирования скорости вращения 
шагового двигателя и, соответственно, скорости линейного перемещения платформы 
позиционирования. 

 

ВНИМАНИЕ! Настоятельно рекомендуется визуально наблюдать за 
процессом позиционирования. 
Помните! Вы можете остановить двигатели в любой момент нажатием 
любой клавиши на клавиатуре управляющего ПК! 

Индикатор выполнения внизу зоны XY Positioning отображает в ручном режиме (при 
отключенной опции Auto) процесс исполнения двигателями заданного количества шагов. 
Необходимо иметь ввиду, что индикатор отображает шаги, заданные системой управления 
шаговым двигателям, но не физическое перемещение платформы. 

Строка состояния внизу панели показывает текущей процесс, исполняемый системой 
управления шаговыми двигателями. 

2.9 Окно визуализации АСМ-изображения  

Окно визуализации АСМ-изображения (Рис. 2.16) выводится при запуске процесса 
сканирования. В окне в двухмерном виде отображаются получаемые АСМ-данные и 
вспомогательная информация: номер текущей измеряемой линии (Line), время установленной 
задержки (Delay), время, прошедшее после запуска текущего сканирования (Elapsed time), 
расчетное время сканирования текущего участка (Total time), скорость сканирования в герцах – 
линиях в секунду (Scan freq, Hz). Дополнительно в зоне визуализации представлена 
информация о размере сканируемого участка (числа на осях изображения), цветовая шкала 
высот на изображении (вертикальная шкала справа от изображения) и размер матрицы 

сканирования в точках (под изображением). Кнопка  (Send this image in area control panel) 
служит для загрузки полученного АСМ-изображения в графическую зону панели настройки 
параметров области сканирования Area для использования при последующих настройках 

области измерений. Кнопка  (Skip Run-in) позволяет оператору при ее нажатии 
принудительно завершить процедуру начальной «приработки» сканера к полю сканирования и 
приступить непосредственно к измерению. Тем не менее слеудует учитывать, что чем меньше 
период «приработки», тем большие искажения начальных линий области сканирования будут 
наблюдаться на АСМ-изображении. 

Опции continual scan и dump each image, соответственно, включают режим непрерывного 
(безостановочного) сканирования заданного поля и сохранение каждого оконченного 
изображения, полученного в режиме непрерывного сканирования, в секторе измеренных 
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данных. В режиме непрерывного сканирования прибор по окончании регистрации АСМ-
изображения автоматически начинает сканировать его же, но в обратном направлении, и так 
далее. Это производится до прерывания процесса оператором. Данная функция позволяет 
макисмально устранить искажения получаемого изображения уже при третьем проходе, 
поскольку пьезосканер за это время получает возможность “приработаться”. 
Первое окно визуализации АСМ-изображения, активируемое при запуске сканирования, 
является основным по отношению к другим окнам визуализации, включаемым при 
необходимости в процессе измерения. Одновременно с первым окном визуализации АСМ-
изображения выводится окно текущего профиля (Рис. 2.16). Линия в его графической зоне 
соответствует сканируемому в настоящий момент профилю. Регуляторы слева и справа 
графической зоны позволяют вручную сдвигать, соответственно, нижнюю и верхнюю границы 
отображаемого вертикального диапазона и таким образом масштабировать его. Группа опций 
Show позволяет включать автоматическое масштабирование вертикального диапазона (Autosize 
profile), отображение предыдущего измеренного профиля (Previous profile) и выводить 
информацию об обозначениях на графике (Legend). Информация о минимальном и 
максимальном значениях высот на линиях профиля, измеренных в ходе текущего сканирования, 
также выводится в панели в области Info. 

 

 

 

Рис. 2.16. Окно визуализации АСМ-изображения (вверху) и окно визуализации текущего профиля (внизу). 

По умолчанию окно визуализации отображает двухмерный образ и профиль измеряемой 
топографии. Правым щелчком мыши в области визуализации выводится контекстное меню, 
позволяющее произвести обновление выводимого изображения (Refresh), открыть дочернее 
окно двухмерной визуализации (New window), открыть новое окно визуализации профиля (New 
profile) и сменить тип отображаемых данных. Набор типов данных, доступных для выбора в 
данном случае, определяется режимом производимых измерений: в статическом режиме это 
топография (Topography), отклонения кантилевера (Deflection) – сигнал ошибки, кручение 
кантилевера (Torsion); в динамическом режиме это топография (Topography), амплитуда 
колебаний кантилевера (Amplitude) – сигнал ошибки, сдвиг фазы колебаний кантилевера 
(Phase). Допускается открытие любого необходимого количества дочерних окон и 
отображаемого типа данных в них. Однако необходимо помнить, что процесс вывода 
изображений требует определенных вычислительных ресурсов в управляющем ПК, поэтому 
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слишком большое количество открытых окон визуализации может в итоге значительно 
замедлить процесс сканирования. 

Данные, измеряемые при многослойном сканировании, визуализируются в 
специализированном окне Multilayer scanning / Tomography (Рис. 2.17). В нем отображается 
процесс получения либо одного слоя, либо всех слоев одного за другим по мере их измерения 
прибором (при активированной опции Show layers alternately). Справа от зоны визуализации 
измеряемых СЗМ-данных находится цветовая шкала высот и область, в которой выводится 
информация о параметрах производимого сканирования и обеспечивается возможность 
настройки некоторых вспомогательных функций визуализации.  

Селектор слоев Layer определяет, какой слой из всего измеряемого набора будет 
отображаться в окне визуализации при отключенной опции Show layers alternately (номер 
начального слоя – 0). Общее количество слоев выводится за селектором. Опция Show layers 
alternately включает режим отображения в зоне визуализации всех слоев поочередно (одного за 
другим по мере их измерения). Селектор Layer при этом будет информировать о номере 
текущего измеряемого слоя. Значение Shown Rsp показывает параметр set-point, 
соответствующий текущему визуализируемому слою. Вертикальный индикатор под значением 
Shown Rsp в графической форме представляет изменения параметра set-point от верхнего 
значения до нижнего. В окне также представляется информация о времени, прошедшем после 
начала данной процедуры сканирования (Elapsed time) и расчетное время, необходимое для 

выполнения текущей процедуры (Total time). Кнопка  (Send this image in area control panel) 
служит для загрузки полученного АСМ-изображения в графическую зону панели настройки 
параметров области сканирования Area для использования при последующих настройках 
области измерений. Полоса внизу окна используется как индикатор выполнения процедуры 
сканирования. 

 

 

Рис. 2.17. Окно визуализации АСМ-данных при многослойном сканировании. 

Тип данных, отображаемый в окне, может быть выбран в контекстном меню, вызываемом 
щелчком правой кнопки мыши в области окна (Рис. 2.18). Контекстное меню также содержит 
команды для открытия нового окна визуализации (например, для отображения другого типа 
измеряемых данных) и/или окна для визуализации набора профилей, измеренных вдоль 
текущей линии быстрого сканирования во всех слоях. 

Контекстные меню в дочерних окнах визуализации позволяют выбрать тип отображаемых 
данных, а в окне двухмерного изображения – выбрать номер отображаемого слоя. 
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Рис. 2.18. Контекстное меню окна визуализации АСМ-данных при многослойном сканировании и открытые дочерние 
окна. 

2.10 Панель калибровочных параметров 

Панель Calibrate АFМ Data (Рис. 2.19) используется для ввода калибровочных 
параметров, используемых измерительной системой АСМ для отображения и записи в файлы 
данных, полученных с помощью прибора, правильной информации о топографии поверхности и 
других величинах. Панель активируется командой меню Task > Calibrate. 

В полях X range, nm, Y range, nm и Z range, nm вводится информация о диапазонах 
движения пьезосканера в направлениях X, Y, Z, соответственно. Эти значения определяются из 
анализа АСМ-изображений тест-образцов, которые представляют собой специально 
изготовленные периодические поверхностные структуры (обычно на кремнии) с известной 
геометрией элементов рельефа (шаг и высота элементов рельефа).  

Например, для расчета диапазона движения пьезосканера по оси X необходимо 
подсчитать количество периодов элементов рельефа на АСМ-изображении тест-образца 
(включая неполные периоды) при установленном максимальном поле сканирования и умножить 
это число на шаг периода. Для калибровки диапазона вертикального движения пьезосканера 
сравнивают высоту элементов тест-образцов на АСМ-изображении с действительными 
параметрами. В данном случае необходимо разделить существующий вертикальный диапазон на 
высоту элемента рельефа, определенную по АСМ-изображению, и затем умножить результат на 
действительную высоту элемента. Найденные при этом параметры вводятся в полях X range, 
nm, Y range, nm и Z range, nm панели калибровки Calibrate АFМ Data . 

Параметры Deflection и Torsion в панели калибровки Calibrate AFM data описывают 
количество бит, используемых АЦП измерительной системы для измерения, соответственно, 
отклонения и кручения кантилевера при сканировании поверхности. Для 16-битного АЦП, 
установленного в системе, это величины составляют 65536. 

Угол сдвига фазы Phase описывает пределы изменения этого параметра и обычно 
устанавливается равным 360. Параметр четвертого канала 4th channel зарезервирован для 
разрабатываемых функций и определяется так же, как параметры Deflection и Torsion. 
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Рис. 2.19. Панель основных калибровочных параметров системы. 

Параметры Min amplitude и Max amplitude устанавливают минимальное и максимальное 
значения для выходного сигнала фотодетектора (в мВ). Эти параметры определяются и 
устанавливаются изготовителем при настройке прибора.  

Значение Spring constant – жесткость используемого для измерений кантилевера в 
единицах Н*м. Если точная величина жесткости кантилевера неизвестна, рекомендуется взять 
его типичное значение, обычно сообщаемое изготовителем в паспорте зонда. 

Селектор Nonlinearity correction позволяет выбрать тип функции, используемой системой 
сканирования прибора для исправления нелинейностей движения установленного 
пьезосканера. Эта коррекция является программной и использует специальные уравнения для 
устранения неидеальности отклика пьезотрубки на приложенное напряжение и минимизации 
таким образом ошибок позиционирования образца относительно зонда при сканировании. 
Предусматривается простая кубическая (Simple cubic) и расширенная кубическая (Advanced cubic) 
функции коррекции нелинейностей. При установке в селекторе Nonlinearity correction опции None 
функция корректировки движения пьезосканера при сканировании будет отключена. 

При выборе одной из функций коррекции необходимо дополнительно ввести параметры 
корректирующих уравнений. Вспомогательная панель для ввода этих параметров активируется 
при нажатии кнопки  …  справа от селектора Nonlinearity correction. Рекомендуется параметры, 
установленные изготовителем во вспомогательных панелях не изменять. Более подробная 
информация о расчете параметров используемых в АСМ NT-206 уравнений коррекции и работе 
со вспомогательными панелями представлена в приложении. Необходимо отметить, что при 
выборе одной из корректирующих функций параметры X range, nm, Y range, nm в основной 
панели калибровки Calibrate AFM Data перестает использоваться системой, и считывается из 
наборов параметров для корректирующих уравнений. 
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В блоке Scanner, расположенном в нижней части панели калибровки, размещены селектор 

и сервисные кнопки, позволяющие сохранить текущий профиль калибровки в отдельных файлах 
(эти файлы сохраняются обычно в той же папке, что и сама программа). При нажатии кнопки 

 вызывается стандартная панель сохранения файла, в котором будет сохранен текущий 
профиль калибровки: 

 

 
 
Пользователю при этом необходимо задать имя файла (оно же – наименование профиля 

калибровки), которое затем можно будет загрузить. Загрузка ранее сохраненных профилей 

калибровки призводится в стандартном диалоге, вызываемом нажатием кнопки . 

2.11 Сектор измеренных данных 

Сектор измеренных данных – область в нижней части окна программы управления служит 
для организации работы пользователя с измеренными данными (Рис. 2.20). Сектор активируется 

при нажатии кнопки  в линейке инструментов или командой меню View > Container. После 
каждого завершения процедуры измерения в сектор отсылается пиктограмма, представляющая 
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собой уменьшенный вариант только что полученного(-ых) АСМ-изображения(-ий) или 
двухмерного графика функции динамической силовой спектроскопии. Текстовое поле под 
каждой пиктограммой представляет информацию о порядковом номере изображения, 
измеренного в текущем сеансе работы программы управления, размер АСМ-изображения в мкм 
и имя файла, в котором эти СЗМ-данные были сохранены на жестком диске. Если АСМ-
изображение, находящееся в секторе измеренных данных, не было после его получения 
сохранено в файле, вместо имени файла выводится сообщение ‘Not saved’.  

 

 

Рис. 2.20. Фрагмент сектора измеренных данных с активированным контекстным меню. 

Контекстное меню каждой пиктограммы, активируемое при щелчке правой кнопки мыши 
на необходимой пиктограмме, содержит следующие команды (Рис. 2.20): 

 Show – открывает новое окно визуализации АСМ-данных и загружает в него текущее 
АСМ-изображение; 

 Save – вызов диалога сохранения файла для записи текущего набора данных в файл 
на жестком диске; 

 Delete – удаление текущего АСМ-изображения из сектора измеренных данных и 
временного буфера; 

 Save all – сохранение всех АСМ-изображений, имеющихся в секторе, в файлах на 
жестком диске с автоматической генераций их имен; 

 Clear – удаление всех изображений из сектора измеренных данных и временного 
буфера. 

 

Помните, что все измеренные данные первоначально сохраняются во 
временном буфере программы SurfaceScan. Возможность сохранения 
всех их на жестком диске имеется всегда, пока программа не закрыта 
(т.е. пока они присутствуют в виде пиктограмм в секторе измеренных 
данных). 

2.12 Панель настроек 

Команда меню File > Options выводит панель установки вспомогательных настроек 
программы (Рис. 2.21). Она помогает конфигурировать программу управления и изменять 
цветовые схемы на соответствующих страницах диалога. 

Страница общих параметров General обеспечивает установку следующих опций: 
 Start each scan in the same window – в активном состоянии указывает на использование 

одного окна визуализации для всех сканирований; 
 зона Eliminate profile tilt on the fly – опреативное вычитание наклона из измеряемой 

линии профиля. Возможные функции – None (вычитание наклона отключено), 1st order 
line (вычитание средней линии наклона первого порядка, т.е. прямой). Переключатель 
Save non-corrected data позволяет сохранять АСМ-данные в файле в исходном виде – 
т.е. без вычитания наклона (если предыдущая опция активирована); 

Страница Tools определяет параметры для запуска из линейки инструментов 
вспомогательных программ из пакета. В разделе Video определяется доступ к средствам 
управления встроенной видеосистемой и окном визуализации, которые будут задействованы 

при нажатии кнопки  в линейке инструментов. При выборе внутреннего управления (Internal) 
необходимо с помощью кнопки Source указать драйвер видеосистемы из списка установленных 
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на данном ПК. такая установка позволит использовать системные средства управления 

видеосистемой при нажатии кнопки  в линейке инструментов. Если выбрана опция внешнего 
управления видеосистемой (External), необходимо определить пути к соответствующим 

приложениям в поле Path (можно воспользоваться кнопкой  …  для поиска приложения на 
жестком диске управляющего ПК). Дополнительно в поле Window caption можно определить 
пользовательский заголовок для окна визуализации видеосистемы. Раздел SurfaceView 
страницы позволяет определить путь к программе обработки, визуализации и анализа АМ-

данных SurfaceView, которое впоследствии можно будет оперативно запускать кнопкой  из 
линейки инструментов управляющей программы  

 

 

Рис. 2.21. Панель установки вспомогательных настроек программы SurfaceScan с активной страницей общих 
параметров. 

Секция установки цветовых схем (Color) дает возможность определить пользовательские 
цвета для АСМ-изображений в окне визуализации (страница Image). Предусматривается выбор 
цветов для верхнего и нижнего уровней отображаемых данных. Страница Indicator дает 
возможность настроить цветовую схему панели Indicator . 
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3 ПРОВЕДЕНИЕ ИЗМЕРЕНИЙ НА АСМ NT-206 
В ПРОГРАММЕ SURFACESCAN 

В данной главе описываются действия, которые необходимо последовательно выполнять 
при измерениях на АСМ NT-206 под управлением программы SurfaceScan. Перед началом 
работы необходимо выполнить подготовительные процедуры, описанные в инструкции по 
эксплуатации АСМ NT-206, согласно следующей очередности. 

1. Включите АСМ, в панели Laser включите питание лазерного модуля. 
2. Проверьте наличие зонда в держателе и переустановите или замените его при 

необходимости. 
3. Проверьте настройку системы детектирования и если необходимо – выполните ее. 
4. Установите образец в АСМ. 
После выполнения данных процедур необходимо выбрать задачу и режим работы для 

АСМ. Наиболее распространенная задача для АСМ – сканирование матрицы (области на 
поверхности образца), что позволяет получить изображения топографии и некоторых 
контрастов. Спектроскопия предоставляет в распоряжение исследователя дополнительную 
важную информацию о состоянии и свойствах поверхности. 

3.1 Статический режим 

3.1.1 Предварительные настройки 

Статический режим включается селектором Mode в панели Main программы управления 
(Рис. 2.1).  

В статическом режиме зонд входит в контакт с исследуемой поверхностью (поэтому 
статический режим часто называют также и контактным). Основной параметр, который 
измерительная система поддерживает в ходе сканирования постоянным, – это отклонение 
кантилевера от нейтрального (свободного) положения. Уровень отклонения и, фактически, 
нагрузки, оказываемой зондом на поверхность, задается регулятором Load в панели FeedBack. 

Главным условием измерений в статическом режиме является способность измерительной 
системы отслеживать полный диапазон отклонений кантилевера при сканировании. Поэтому 
перед сканированием система детектирования должна быть настроена соответствующим 
образом согласно процедурам, описанным в руководстве по эксплуатации АСМ NT-206. Для 
гарантии устойчивой работы можно предварительно (перед подводом) поднять пятно лазера на 
фотодетекторе (примерно на половину его диаметра) с помощью ручки Detector Y.  

Дальнейшая подготовка предусматривает: 
 Регулятор задержки обратной связи FB Delay в панели FeedBack рекомендуется 

установить на значение 1–3. Минимальные значения предпочтительны, однако 
для повышения стабильности измерительной системы допускается увеличение 
параметра. 

 Параметр Z trace steps в панели FeedBack рекомендуется задать порядка 61–63. 
Большие значения параметра замедляют сканирование, но предотвращают 
повреждение и износ острия зонда и позволяют точнее производить измерение 
высоты микрорельефа. Если известно, что сканируемая поверхность гладкая (с 
высотами менее 10 нм), то параметр Z trace steps  может быть существенно 
снижен. 
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 Задать подеерживаемую системой нагрузку на кантилевер:   

1) нажатием кнопки >0< у регулятора Load в панели FeedBack программы 
управления обнулить текущую нагрузку кантилевера (фактически – сообщить 
системе, что текущее положение кантилевера является его нейтральным, т.е 
свободным положением);  
2) регулятором Load (или в соответсвующем цифровом поле) установить нагрузку 
порядка 10…15%.  

 Установить параметры ПИД-регулятора в панели FeedBack программы 
управления: 
Proportional gain .......................................... 1–3; 
Integral gain ................................................ 2–6; 
Differential gain ......................................... 0.1–3;  (меньшее предпочтительно) 
Количество измерений в точке Meas. ...............8; 
Число циклов обработки Cycles ...................... 12. 

 
Приведенные настройки системы обратной связи рекомендуется применять при 

измерении поверхности с неизвестной твердостью и микрорельефом. Однако, если для 
исследуемого образца поверхности ранее были подобраны другие рабочие параметры 
сканирования, то предпочтительно использовать именно их. Также рекомендуется в случае 
нестабильной работы измерительной системы при заданных настройках варьировать их с целью 
подбора наиболее оптимальных режимов измерений для конкретных образцов поверхностей. 

3.1.2 Сближение зонда с поверхностью (подвод поверхности 
к зонду) 

Процедура подвода непосредственно предшествует процессу измерения и должна 
выполняться в автоматическом режиме, поскольку система управления может достаточно точно 
зафиксировать вступление зонда в контакт с поверхностью и отключить подвод в необходимый 
момент (при правильно настроенной системе детектирования и удовлетворительном состоянии 
исследуемой поверхности – отсутсвии на ней жидких, масляных, жировых и др. загрязнений, а 
также незафиксированных нано- и микрочастиц). 

В АСМ NT-206 предусмотрено вертикальное перемещение платформы (предметного 
столика) с образцом с несколькими скоростями. Данную особенность можно использовать для 
ускорения процесса подвода. Например, произвести быстрый подвод образца к зонду на 
расстояние порядка 1 мм, а затем, установив меньшую скорость вращения шагового двигателя 
вертикального перемещения, завершить процесс автоматического подвода. Скорость вращения 
двигателя вертикального перемещения регулируется установкой задержки селектором 
Drive delay в панели Main. При этом следует учитывать, что большее значение задержки 
(фактически – паузы между шагами электродвигателя) соответствует меньшей скорости 
подвода.  

Таким образом, грубый подвод можно осуществить, установив значение задержки Drive 

delay 1.36–2.72 мкс и нажав кнопку автоподвода . Оператор при этом должен визуально 
следить за процессом подвода и по достижении рсстояния между образцом и зондом порядка 1 

мм остановить грубый подвод, нажав кнопку  (STOP) в панели Main. или клавишу Esc на 
клавиатуре управляющего компьютера. 

Дальнейший подвод выполняется в следующей последовательности. 
1. Установите повышенное значение задержки Drive delay в панели Main, например, 2.72 мкс, 

для обеспечения низкой скорости подвода. 

2. Нажмите на кнопку  в зоне автоматического подвода ::: Auto ::: и ожидайте 
автоматической остановки подвода, о чем будет выведено соответствующее сообщение. 
После этого кнопка автоподвода будет заблокирована и дальнейший подвод к поверхности 
будет возможен только в ручном режиме. 
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3. Если индикатор Z в панели Indicators не находится в середине диапазона (Рис. 2.3), 
необходимо дополнительно подвести (если индикатор выше середины) или отвести (если 
индикатор ниже середины) поверхность относительно зонда. Для этого введите некоторое 
(3–20) количество шагов, которое определит диапазон перемещения шагового двигателя 
после нажатия кнопки. После этого в зоне ручного управления подводом нажмите кнопку 

 (TO) или  (OFF), соответственно, для подвода или отвода образца относительно 
зонда. Эти кнопки необходимо нажимать многократно до тех пор, пока индикатор Z не 
переместится в середину своего диапазона. 

3.1.3 Сканирование 

Процедура сканирования предусматривает проведение определенных настроек 
измерительной системы и собственно запуск процесса измерения, которые необходимо 
выполнить в следующей последовательности. 

1. Перед началом сканирования установите необходимое значение параметра Load 
(панель Feedback, Рис. 2.9). Помните, что чем ниже установлена метка Load в панели 
индикаторов (Рис. 2.3 слева), тем больший изгиб кантилевера будет считаться его 
рабочим состоянием и поддерживаться системой при сканировании, а соответственно, 
с тем большей силой острие зонда будет воздействовать на поверхность.  

2. Проверить скорость обратной связи. Слишком высокая скорость обратной связи 
(низкое значение задержки FB Delay в панели Feedback, Рис. 2.9) может стать 
причиной самовозбуждения измерительной системы и резко ухудшить качество АСМ-
изображения. Признаки появления самовозбуждения в системе – появление 
периодических помех («ряби») на АСМ изображении или наложение искусственной 
периодической составляющей на линиях профиля или кривой зависимости сила–
расстояние (при спектроскопии в точке). Учитывая эти соображения, при 
необходимости снизить скорость обратной связи постепенно повысьте значение 
задержки FB Delay и/или параметра Z trace steps в панели Feedback. Также можно 
снизить параметры Proportional gain и повысить Integral gain в блоке PID regulators 
панели. 

3. В панели Area программы управления АСМ выделить область сканирования (Рис. 
2.14c). При первом сканировании образца или нового участка на нем рекомендуется 
установить максимальное поле сканирования.  

4. В панели Area установите необходимые параметры для количества точек по осям X и 
Y (Num points X, Num points Y), размера шага между точками измерения (Step, nm), 
длительности задержки измерения в точке измерения (Delay, mks). 

5. Выбрать схему движения зонда в селекторе Pattern. Предпочтительной является схема 

. 
6. Запустить процесс сканирования – нажать либо кнопку Start в нижней части панели 

Main (Рис. 2.1), либо кнопку  (Start scanning on the set matrix) в линейке 
инструментов, либо выбрать команду меню Task > Scanning matrix. После запуска 
процесса измерения на экран будет выведено окно визуализации АСМ-изображения и 
дополнительное окно визуализации текущего профиля, в которых можно наблюдать 
за процессом измерения, что позволит визуально контролировать качество 
получаемого АСМ-изображения. Допускается также в ходе «пробного» сканирования 
подстраивать параметры задержки FB Delay, Z trace steps, Proportional gain и Integral 
gain в панели Feedback. В ходе измерений оператору рекомендуется наблюдать за 
процессом для предупреждения выхода измеряемой высоты за пределы допустимого 
диапазона вертикального движения пьезосканера. При этом особенно критична для 
системы ситуация, когда сканер полностью сжимается (полностью исчезают 
показания на индикаторе Z), что свидетельствует о превышении высоты рельефа 
верхнего предела вертикального движения пьезосканера. Итогом этого может стать 
повреждение зонда и самой поверхности. При возникновении подобной ситуации 
рекомендуется остановить процесс сканирования и немного отвести поверхность от 
зонда, но оставляя тем не менее их в контакте (т.е. показания индикатора Z должны 
после такого отвода оставаться ниже максимума). 
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7. Процесс сканирования будет завершен автоматически, о чем будет выведено 
соответствующее сообщение. Если возникнет необходимость остановить сканирование 
до его автоматического завершения, нажмите кнопку Stop в панели Main или кнопку 

 в линейке инструментов программы управления.  
8. По завершении процесса сканирования полученное АСМ-изображение будет 

переслано в сектор измеренных данных. Рекомендуется полученное АСМ-изображение 
сохранить в файле на жестком диске. 

Если необходимо просканировать другой участок на поверхности образца, переместите 
измерительную головку с помощью автоматизированной платформы грубого позиционирования. 
При этом за перемещением зонда относительно образца можно наблюдать с помощью 
интегрированной видеосистемы. Не забудьте, что перед сменой участка сканирования 
необходимо незначительно отвести поверхность от зонда. Для этого установите в панели Main 
значение порядка 50–100 шагов (Steps) в зоне ручного управления (:::Manual:::) двигателем 

вертикального перемещения образца (Рис. 2.2 слева) и нажмите в этой зоне кнопку  (OFF), 
чтобы отвести поверхность от зонда в ручном режиме. После отвода индикатор Z должен 
показывать максимальное значение (т.е. растяжение сканера), а кнопка автоподвода 
активизироваться. Перемещение измерительной головки производится шаговыми двигателями, 
управляемыми в панели Drives (Рис. 2.15). После установки измерительной головки над новым 
участком образца можно продолжить измерения, повторив автоподвод (§3.1.2) и последующие 
процедуры сканирования. 

3.1.4 Завершение работы 

Для завершения работы АСМ выполните следующие процедуры. 
1. Остановите сканирование, если оно не завершено автоматически. 
2. Установите максимальную скорость обратной связи (т.е. минимальное значение 

задержки FB Delay в панели Feedback). 

3. В панели Main нажмите кнопку автоотвода  (OFF) в зоне управления 
автоматическим движением двигателя вертикального перемещения образца. 
Альтернативно можно также установить количество шагов (Steps) не менее 50 в зоне 

ручного управления (:::Manual:::) и нажать кнопку ручного отвода  (OFF). После 
выхода поверхности из контакта с зондом индикатор Z увеличится до максимального 
значения. Продолжайте выполнять отвод до тех пор, пока острие зонда не окажется 
на достаточно большом расстоянии от образца, что необходимо проконтролировать 
визуально. Если необходимо, снимите образец с предметного столика. 

4. Удостоверьтесь, что все необходимые АСМ-изображения, накопленные в секторе 
измеренных данных, сохранены в файлах на жестком диске и сохраните их если этого 
не было сделано. 

5. Выключите лазер (отожмите кнопку Laser в панели Laser, Рис. 2.5). 

6. Выключите блок электроники управления с помощью кнопки Power на его передней 
панели.  

7. Закройте программу управления АСМ. 
8. При необходимости выключите управляющий компьютер. 

3.2 Динамический режим 

3.2.1 Предварительные настройки 

Динамический режим включается селектором Mode в панели Main программы управления 
(Рис. 2.1). Предварительно необходимо настроить систему детектирования в статическом 
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режиме согласно процедурам, описанным в руководстве по эксплуатации АСМ NT-206 и §2.3 
настоящего руководства. После этого можно переключить систему для работы в динамическом 
режиме. Для проверки позиционирования светового луча на фотодетекторе в динамическом 
режиме предусмотрена кнопка временного переключения Temp. static в панели Laser.  

В динамическом режиме зонд колеблется на своей резонансной частоте вблизи 
исследуемой поверхности и в случае измерений в промежуточном режиме входит в контакт с 
ней в нижней точке своего цикла колебаний. Основным параметром, который поддерживает 
измерительная система является амплитуда колебаний кантилевера (устанавливается 
регулятором Load в панели FeedBack). Принцип использования колебаний на резонансной 
частоте позволяет существенно повысить чувствительность измерительной системы, однако он 
также требует проведения дополнительной настройки параметров колебаний кантилевера. 

Подготовительные настройки заключаются в установке регулятора Load в панели 
FeedBack программы управления (Рис. 2.9) (обычно таким образом, чтобы метка индикатора 
Load располагалась в середине диапазона или немного ниже). Рекомендуется также регулятор 
задержки обратной связи FB Delay установить на значение 3–10 (около 10–30% от полного 
диапазона начиная от минимального уровня). 

3.2.2 Настройка параметров колебаний (осцилляции) 
кантилевера  

Настройка параметров колебаний кантилевера производится в панели Generator, а 
также в дополнительной панели сканирования частоты колебаний кантилевера Frequency 
Sweep программы управления АСМ. 

1. Установите регулятор Amplitude Range в панели Generator в среднее положение. 
2. Установите регулятор Phase в положение около 1/4 от полного диапазона. 
3. Нажмите кнопку Get Freq. Sweep в панели Generator для вывода дополнительной 

панели Frequency Sweep. 
4. Если необходимо, введите необходимые значения в полях начальной границы области 

сканирования частоты Start (Hz), ее окончания Stop (Hz), и количества точек данных на 
кривой # of points в дополнительной панели Frequency Sweep. 

5. Нажмите кнопку Start в дополнительной панели Frequency Sweep. После окончания 

процедуры сканирования частоты, система автоматически определит наивысший пик 
на полученной кривой амплитуды и автоматически установит соответствующие 
величины частоты и фазы в панели Generator. Если высота максимального пика на 
кривой амплитуды ниже максимума (верхней границы поля графика) или превышает 
его (срезается «верхушка» пика), необходимо с помощью регулятора амплитуды 
колебаний Amplitude Range подобрать такую ее величину, чтобы при последующих 
сканированиях частоты наибольший пик по высоте достигал верхней границы поля 
графика или был немного ниже ее. При необходимости ступенчато понизить амплитуду 
(в случае, если регулятор Amplitude Range находится около своего минимального 
уровня) рекомендуется воспользоваться переключателем Reduct, dB панели 
Generator. 

6. Если автоматически определенный пик не соответствует Вашим требованиям, 
установите необходимую частоту (выберите соответствующий пик) перемещением 
курсора (горизонтальный регулятор под графическим полем на панели, Рис. 2.7, §2.4). 
Вы также можете увеличить зону вокруг курсора для того, чтобы просканировать 
интересующий диапазон с бОльшим разрешением. Для этого воспользуйтесь 
регулятором Range limits дополнительной панели Frequency Sweep, который 
визуально определит границы нового участка на шкале частот в поле графика и 
установит соответствующие значения для начальной границы области сканирования 
частоты Start (Hz) и ее окончания Stop (Hz). Повторное сканирование нового диапазона 
запускается кнопкой Start дополнительной панели Frequency Sweep. 

3.2.3 Подвод поверхности к зонду 

В АСМ NT-206 предусмотрено вертикальное перемещение платформы (предметного 
столика) с образцом с несколькими скоростями. Данную особенность можно использовать для 
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ускорения процесса подвода. Например, произвести быстрый подвод образца к зонду на 
расстояние порядка 1 мм, а затем, установив меньшую скорость вращения шагового двигателя 
вертикального перемещения, завершить процесс автоматического подвода. Скорость вращения 
двигателя вертикального перемещения регулируется установкой задержки селектором 
Drive delay в панели Main. При этом следует учитывать, что большее значение задержки 
(фактически – паузы между шагами электродвигателя) соответствует меньшей скорости 
подвода.  

Таким образом, грубый подвод можно осуществить, установив значение задержки Drive 

delay 1.36–2.72 мкс и нажав кнопку автоподвода . Оператор при этом должен визуально 
следить за процессом подвода и по достижении рсстояния между образцом и зондом порядка 1 

мм остановить грубый подвод, нажав кнопку  (STOP) в панели Main. или клавишу Esc на 
клавиатуре управляющего компьютера. 

Дальнейший подвод выполняется в следующей последовательности. 
4. Установите повышенное значение задержки Drive delay в панели Main, например, 2.72 мкс, 

для обеспечения низкой скорости подвода. 

5. Нажмите на кнопку  в зоне автоматического подвода ::: Auto ::: и ожидайте 
автоматической остановки подвода, о чем будет выведено соответствующее сообщение. 
После этого кнопка автоподвода будет заблокирована и дальнейший подвод к поверхности 
будет возможен только в ручном режиме. 

6. Если индикатор Z в панели Indicators не находится в середине диапазона (Рис. 2.3), 
необходимо дополнительно подвести (если индикатор выше середины) или отвести (если 
индикатор ниже середины) поверхность относительно зонда. Для этого введите некоторое 
(3–20) количество шагов, которое определит диапазон перемещения шагового двигателя 
после нажатия кнопки. После этого в зоне ручного управления подводом нажмите кнопку 

 (TO) или  (OFF), соответственно, для подвода или отвода образца относительно 
зонда. Эти кнопки необходимо нажимать многократно до тех пор, пока индикатор Z не 
переместится в середину своего диапазона. 

3.2.4 Сканирование 

Процедура сканирования предусматривает проведение определенных настроек 
измерительной системы и собственно запуск процесса измерения, которые необходимо 
выполнить в следующей последовательности. 

1. Перед началом сканирования установите необходимое значение параметра Load 
(панель Feedback, Рис. 2.9). Помните, что чем ниже находится метка Load в панели 
индикаторов (Рис. 2.3), тем большее подавление амплитуды колебаний кантилевера 
будет считаться его рабочим состоянием и поддерживаться системой при 
сканировании, а соответственно, с тем большей силой острие зонда будет 
воздействовать на поверхность.  

2. Проверьте скорость обратной связи. Слишком высокая скорость обратной связи 
(низкое значение задержки FB Delay в панели Feedback, Рис. 2.9) может стать 
причиной самовозбуждения измерительной системы и резко ухудшить качество АСМ-
изображения. Признаки появления самовозбуждения в системе – появление 
периодических помех («ряби» или муара) на АСМ изображении или наложение 
искусственной периодической составляющей на линиях профиля или кривой 
зависимости сила–расстояние (при спектроскопии в точке). Учитывая эти 
соображения, при необходимости снизить скорость обратной связи постепенно 
повысьте значение задержки FB Delay и/или параметра Z trace steps в панели 
Feedback. Также можно снизить параметры Proportional gain и повысить Integral gain 
в блоке PID regulators панели.  

3. В панели Area программы управления АСМ выделить область сканирования (Рис. 
2.14c). При первом сканировании образца или нового участка на нем рекомендуется 
установить максимальное поле сканирования.  
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4. В панели Area установите необходимые параметры для количества точек по осям X и 
Y (Num points X, Num points Y), размера шага между точками измерения (Step, nm), 
длительности задержки измерения в точке измерения (Delay, mks). 

5. Выбрать схему движения зонда в селекторе Pattern. 

6. Запустить процесс сканирования – нажать либо кнопку Start в нижней части панели 

Main (Рис. 2.1), либо кнопку  (Start scanning on the set matrix) в линейке 
инструментов, либо выбрать команду меню Task > Scanning matrix. После запуска 
процесса измерения на экран будет выведено окно визуализации АСМ-изображения и 
дополнительное окно визуализации текущего профиля, в которых можно наблюдать 
за процессом измерения, что позволит визуально контролировать качество 
получаемого АСМ-изображения. Допускается также в ходе «пробного» сканирования 
подстраивать параметры задержки FB Delay, Z trace steps, Proportional gain и Integral 
gain в панели Feedback. В ходе измерений оператору рекомендуется наблюдать за 
процессом для предупреждения выхода измеряемой высоты за пределы допустимого 
диапазона вертикального движения пьезосканера. При этом особенно критична для 
системы ситуация, когда сканер полностью сжимается (полностью исчезают 
показания на индикаторе Z), что свидетельствует о превышении высоты рельефа 
верхнего предела вертикального движения пьезосканера. Итогом этого может стать 
повреждение зонда и самой поверхности. При возникновении подобной ситуации 
рекомендуется остановить процесс сканирования и немного отвести поверхность от 
зонда, но оставляя, тем не менее, их в контакте (т.е. показания индикатора Z должны 
после такого отвода оставаться ниже максимума). 

7. Процесс сканирования будет завершен автоматически, о чем будет выведено 
соответствующее сообщение. Если возникнет необходимость остановить сканирование 
до его автоматического завершения, нажмите кнопку Stop в панели Main или кнопку 

 в линейке инструментов программы управления.  
8. По завершении процесса сканирования полученное АСМ-изображение будет передано 

в сектор измеренных данных программы. Рекомендуется полученное АСМ-
изображение сохранить в файле на жестком диске. 

Если необходимо просканировать другой участок на поверхности образца, переместите 
измерительную головку с помощью автоматизированной платформы грубого позиционирования. 
При этом за перемещением зонда относительно образца можно наблюдать с помощью 
интегрированной видеосистемы. Не забудьте, что перед сменой участка сканирования 
необходимо незначительно отвести поверхность от зонда. Для этого установите в панели Main 
значение порядка 50–100 шагов (Steps) в зоне ручного управления (:::Manual:::) двигателем 

вертикального перемещения образца (Рис. 2.1) и нажмите в этой зоне кнопку  (OFF), чтобы 
отвести поверхность от зонда в ручном режиме. После отвода индикатор Z должен показывать 
максимальное значение (т.е. растяжение сканера), а кнопка автоподвода активизироваться. 
Перемещение измерительной головки производится шаговыми двигателями, управляемыми в 
панели Drives (Рис. 2.15). После установки измерительной головки над новым участком 
образца можно продолжить измерения, повторив автоподвод (§3.2.3) и последующие 
процедуры сканирования. 

3.2.5 Завершение работы 

Для завершения работы АСМ выполните следующие процедуры. 
1. Остановите сканирование, если оно не завершено автоматически. 
2. Установите максимальную скорость обратной связи (т.е. минимальное значение 

задержки FB Delay в панели Feedback). 

3. В панели Main (Рис. 2.1) нажмите кнопку автоотвода  (OFF) в зоне управления 
автоматическим движением двигателя вертикального перемещения образца ::: Auto 
:::. Альтернативно можно также установить количество шагов (Steps) не менее 50 в 

зоне ручного управления (:::Manual:::) и нажать кнопку ручного отвода  (OFF). 
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Для ускорения отвода можно выбрать меньшее значение задержки двигателя в 
селекторе Drive delay панели Main. После выхода поверхности из контакта с зондом 
индикатор Z (Рис. 2.3) увеличится до максимального значения. Продолжайте 
выполнять отвод до тех пор, пока острие зонда не окажется на достаточно большом 
расстоянии от образца, что необходимо проконтролировать визуально. Если 
необходимо, снимите образец с предметного столика. 

4. Удостоверьтесь, что все необходимые АСМ-изображения, накопленные в секторе 
измеренных данных, сохранены в файлах на жестком диске и сохраните их если этого 
не было сделано. 

5. Выключите лазер (отожмите кнопку Laser в панели Laser, Рис. 2.4). 

6. Выключите блок электроники управления с помощью кнопки Power на его передней 
панели.  

7. Закройте программу управления АСМ. 
8. При необходимости выключите управляющий компьютер. 

3.3 Режим двухпроходного сканирования 

Двухпроходное сканирование (Two-pass scanning) является специализированной СЗМ 
методикой для измерения топографии и затем изображения контраста, например карты 
распределения электростатического заряда. Первый проход сканирования используется для 
получения АСМ-изображения топографии. Затем система увеличивает расстояние между зондом и 
образцом и сканирует тот же участок поверхности повторно, перемещая зонд параллельно рельефу 
на основании АСМ-данных, полученных при первом проходе (подобно режиму постоянной силы). 
Прикладывая между острием зонда и поверхностью образца напряжение смещения, прибор при 
втором проходе регистрирует электростатические силы в каждой точке измерений. 

Для реализации двухпроходного сканирования с целью картографирования электростати-
ческих сил необходимо использование специализированных измерительной головки и держателя 
зонда, в которых предусматривается электрическое изолирование установленного 
токопроводящего зонда от корпуса АСМ и приложение к самому токопроводящему зонду 
напряжения смещения. Специализированные измерительная головка и держатель зонда могут 
быть поставлены изготовителем АСМ NT-206. Дополнительно блок электроники управления 
должен быть оснащен специальной схемой, поддерживающей режим двухпроходного скани-
рования с приложением напряжения смещения для картографирования электростатических сил. 

Как уже упоминалось, для картографирования электростатических сил необходимо 
использование токопроводящего зонда. Подобные зонды изготавливаются, например, 
нанесением проводящего покрытия на обычные зонды и могут быть приобретены у их 
производителей, например Mikromasch (www.spmtips.com), NT-MDT (www.ntmdt.com). Отметим, 
что любые функциональные покрытия (в частности, проводящее) увеличивают радиус кривизны 
острия зонда, и поэтому ухудшают пространственное разрешение прибора. 

Двухпроходное сканирование активируется как специальная задача (селектор задач 
Task) в панели Main программы управления АСМ (Рис. 3.1). Картографирование 
электростатических сил предусмотрено для статического режима измерений, для чего в 
селекторе режима Mode необходимо выбрать STATIC. При установке в селекторе задач (Task) 
двухпроходного сканирования (Two-pass scanning) в зоне ниже селектора режима (Mode) 
активируется возможность установки параметров второго (TWO-PASS parameters) прохода: 
предусматривается установка смещения или расстояния отступа, на которое будет поднят зонд 
перед вторым проходом. Данное смещение может быть задано различным для начала и конца 
плоскости второго прохода сканирования, что обеспечит при необходимости ее наклон 
относительно плоскости поверхности образца. Соответственно, если начальное и конечное 
смещения устанавливаются равными, то плоскость сканирования при втором проходе будет 
параллельна плоскости поверхности образца.  
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Рис. 3.1. Главная панель управления сканированием Main, настроенная на проведение измерений по методике 
двухпроходного сканирования (Two-pass scanning mode) (слева) и панель параметров обратной связи (справа), в 

которой устанавливается напряжение смещения (регулятор Tip voltage, V) 

Дополнительный параметр, необходимый для картографирования электростатических сил 
при двухпроходном сканировании, – напряжение смещения – устанавливается регулятором Tip 
voltage, V (Рис. 3.1 справа) в панели обратной связи Feedback. 

После установки вышеуказанных задачи и режима, установки расстояния подъема перед 
вторым проходом и напряжения смещения (Tip voltage, V) дальнейшая работа АСМ сходна с его 
работой при проведении измерений в статическом режиме, описанном в §3.1. Для запуска 

процедуры сканирования необходимо нажать кнопку START в панели Main, или нажать кнопку  в 

линейке инструментов, или выбрать пункт меню Task > Two-pass scanning. Полученный по 
окончании измерений набор данных будет содержать изображение топографии (по первому 
проходу) и изображение контраста (по второму проходу), например, карту электростатических сил. 

Схема движения зонда относительно образца при двухпроходном сканировании 
следующая. Во время первого прохода зонд движется вдоль линии в направлении быстрого 
сканирования, регистрируя данные о высоте рельефа, и по ее завершении возвращается в 
начальную точку этой линии. После этого зонд производит второй проход, двигаясь вдоль той 
же линии, но на расстоянии подъема над поверхностью образца и повторяя профиль рельефа 
по траектории, зарегистрированной при первом проходе (Рис. 3.2). При втором проходе система 
также прикладывает напряжение смещения между острием и поверхностью образца, что 
означает, что отклонение кантилевера будет определяться электростатическим 
взаимодействием между острием и образцом. Таким образом, при втором проходе 
регистрируются данные об электростатических силах в каждой точке измерений. 
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Рис. 3.2. Схема проведения двухпроходного сканирования. 

После завершения второго прохода вдоль первой линии зонд снова возвращается к 
начальной точке линии, снова подводится к поверхности для проведения измерения 
топографии и перемещается вдоль направления медленного сканирования ко второй линии 
измерений. Далее система повторяет описанные выше операции. Если расстояние начального и 
конечного подъема плоскости сканирования второго прохода различны, то расстояние 
смещения зонда будет пропорционально изменяться от линии к линии в направлении 
медленного сканирования. Отметим, что расстояние между траекториями первого и второго 
прохода вдоль направления быстрого сканирования остается постоянным и может измениться, 
только когда зонд переходит к последующей линии быстрого сканирования. Таким образом, при 
необходимости реализовать в эксперименте наклон плоскости второго прохода относительно 
плоскости поверхности образца, совпадающей с плоскостью первого прохода. 

3.4 Многослойное сканирование 

Многослойное сканирование (Multilayer scanning) – это специализированная методика 
автоматизированного получения набора АСМ-изображений для одной и той же области на 
поверхности образца при различных значениях параметра Set-point (практически в данной 
программе – нагрузки Load). Каждый скан, полученный при одном значении параметра Set-point 
рассматривается как слой. Изменение параметра Set-point при переходе от одного скана к 
другому означает, что система контактную силу, с которой острие зонда контактирует с 
исследуемой поверхностью. Данная методика может при определенной математической 
обработке результатов измерений рассматриваться как своего рода томография поверхностных 
слоев. 

Запуск процедуры многослойного сканирования осуществляется нажатием кнопки  в 
линейке инструментов или выбором пункта меню Task > Multilayer scanning. В панели Main 
данная методика может быть установлена выбором задачи Multilayer scanning в селекторе Task, 
установки необходимого режима измерений – динамического или статического (DYNAMIC или 
STATIC) в селекторе Mode, а затем нажатием кнопки START. Заметьте, что предварительно 

необходимо настроить прибор для работы в выбранном режиме – статическом или 
динамическом (см. соответственно §3.1 и §3.2). После старта процедуры многослойного 
сканирования перед ее непосредственным выполнением выводится дополнительная панель для 
установки специальных параметров процедуры Multilayer scanning parameters (Рис. 3.3). В 
этой панели устанавливаются параметры Set-point для первого (Start Rsp) и последнего слоев, а 
также количество слоев (Number of layers). В зависимости от этих величин будут 
пропорционально рассчитаны параметры Set-point для промежуточных слоев. Необходимо 
отметить, что значения параметра Set-point в рассматриваемой вспомогательной панели 
должны вводиться как доли единицы, предполагая, что свободное состояние кантилевера 
соответствует 1, а его полное подавление колебаний или изгиб при прижатии к поверхности – 
0. Допускается устанавливать одно и то же значение параметра Set-point для первого и 
последнего слоев, что будет означать, что система должна произвести многократное 
(соответственно количеству заданных слоев Number of layers) автоматическое сканирование 
одной и той же области. 

 

 

Рис. 3.3. Вспомогательная панель установки специальных параметров процедуры многослойного сканирования. 
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Измерения начинаются после нажатия кнопки Run во вспомогательной панели Multilayer 

scanning parameters. В специализированном окне визуализации Multilayer scanning / 
Tomography отображается процесс получения либо одного слоя, либо всех слоев одного за 
другим по мере их измерения прибором (при активированной опции Show layers alternately). При 
отключенной опции Show layers alternately имеется также возможность с помощью селектора 
Layer определить, какой слой из всего измеряемого набора будет отображаться в окне 
визуализации. Пользователь в контекстном меню, вызываемом правым щелчком мыши в 
области окна, также может выбрать тип измеряемых данных, которые будут отображаться в 
окне визуализации.  

 

 

Рис. 3.4. Окно визуализации АСМ-данных при многослойном сканировании. 

Методически реализация многослойного сканирования сходна с организацией 
двухпроходного сканирования. И в той и другой методике зонд проходит вдоль одной и той же 
линии сканирования многократно с изменяющимися параметрами сканирования. Однако в 
отличие от двухпроходной методики многослойное сканирование не предусматривает подъем 
зонда и вывод его из контакта с поверхностью после сканирования каждой линии. Функция 
многослойного сканирования производит измерение поверхности при движении зонда 
практически в одной плоскости, параллельной этой плоскости (не предусматривая наклона 
плоскости сканирования). При многослойном сканировании также не предусмотрено 
приложение напряжения смещения между зондом и образцом. 

По окончании процедуры многослойного сканирования полученные АСМ-изображения 
каждого слоя сохраняются в отдельных файлах данных. Одновременно с сохранением данных в 
файлах создается их список в отдельном текстовом файле. 

3.5 Силовая спектроскопия 

Функция силовой спектроскопии используется для тонкой настройки измерительной 
системы (статическая силовая спектроскопия или измерение кривых «сила–расстояние»), а 
также как специализированная методика для получения информации о свойствах и состоянии 
поверхности образца (как статическая, так и динамическая силовая спектроскопия).  

Специальные настройки для спектроскопических измерений производятся в панели 
установки параметров и управления этой функцией FvsD (§2.6). Прежде всего здесь 
необходимо установить контролируемый параметр (селектор Controlled parameter). В 
большинстве случаев в качестве контролируемого параметра используется расстояние между 
зондом и образцом Distance. После выбора контролируемого параметра необходимо в таблице 
настроек панели ввести значения для верхней (Top) и нижней (Bottom) границ рабочего 
диапазона перемещения пьезосканера, количество точек на измеряемой кривой (Points), число 
измерений в каждой точке (Measurement) и количество шагов дискретизации между соседними 
точками измерения (StepMove). Вертикальная шкала Z Distance/Set-point в левой части панели 
графически представляет положение верхней и нижней границ рабочего диапазона 
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вертикального движения пьезосканера относительно его полного размаха. Регуляторы слева и 
справа от вертикальной шкалы предназначены для ручной интерактивной установки, 
соответственно, верхней и нижней границ рабочего диапазона перемещения пьезосканера при 
проведении спектроскопии. В панели FvsD также находятся кнопки запуска (Get curve) и 

остановки (Stop) упрощенной процедуры статической силовой спектроскопии для оперативного 
вывода кривой «сила–расстояние» в графической зоне этой панели и панели Feedback. 

Точка в пределах области сканирования, где будут производиться спектроскопические 
измерения, определяется в панели Area (в режиме Point). 

После установки специальных настроек спектроскопии в панели FvsD и определения 
точки измерений запуск упрощенной процедуры измерения осуществляется нажатием кнопки 

Get curve в панели FvsD. Для проведения силовой спектроскопии в расширенном варианте, в 
т.ч. с возможностью выбора режима измерений – статического или динамического – 

необходимо воспользоваться кнопками на линейке инструментов  (статическая силовая 

спектроскопия) и  (динамическая частотная спектроскопия) или соответствующими командами 
меню Task > Spectroscopy in point или Task > Dynamic force spectroscopy. Получаемые при этом 
графики в зависимости от сочетания типа спектроскопии и контролируемого параметра описаны 
в Табл. 3.1. 

Таблица 3.1. Тип графика, получаемого при реализации функции спектроскопии в точке. 

Контролируемый параметр 
Тип спектроскопии 

Расстояние (Distance) Параметр Set-point 

Статическая Отклонение кантилевера = f(Расстояние 
между зондом и образцом) 

Расстояние между зондом и образцом = 
f(Отклонение кантилевера) 

Динамическая Амплитуда колебаний кантилевера = 
f(Расстояние между зондом и образцом) и 
Сдвиг фазы колебаний кантилевера = 
f(Расстояние между зондом и образцом) 

Расстояние между зондом и образцом = 
f(Амплитуда колебаний кантилевера) 

3.5.1 Статическая силовая спектроскопия 

Статическая силовая спектроскопия – это получение кривой зависимости отклонения 
кантилевера зонда от расстояния между его зафиксированным концом и поверхностью 
измеряемого образца, т.е.  = f(S). Статическая силовая спектроскопия производится в точке, 
над которой с помощью сканирующего устройства и реализуется взаимное перемещение зонда 
(точнее – его зафиксированного конца) и образца. Отклонение кантилевера зонда от 
нейтрального положения , происходящее при этом под воздействием поверхностных, а также 
упругих и, возможно, пластических сил со стороны измеряемой поверхности образца, 
регистрируется штатной системой детектирования АСМ и интерпретируется как функция 
расстояния зонд–образец S (рис. 3.5). Если известна жесткость кантилевера зонда, 
зарегистрированное отклонение может быть пересчитано непосредственно в нагрузку (усилие), 
оказываемую острием зонда на поверхность образца, исчисляемую в абсолютных единицах. 
Собственно поэтому данная процедура и носит название «силовая спектроскопия». 
Графическое представление измеренной экспериментальной зависимости  = f(S)  называют 
также кривой подвода/отвода. 

Для проведения спектроскопии в установленной точке необходимо, чтобы зонд АСМ 
находился в контакте с поверхностью, т.е. необходимо настроить систему детектирования и 
осуществить подвод зонда к образцу (или образца к зонду) (см. описание процедуры подвода). 
Предварительно рекомендуется также просканировать участок поверхности образца, чтобы 
использовать изображение участка для выбора интересующей точки для проведения 
спектроскопии (рис. 3.6). 

После завершения сканирования участка поверхности образца, нажмите кнопку  для 
переноса полученного АСМ-изображения в графическую зону позиционирования зонда на 
панели настройки параметров области сканирования Area (рис. 3.6). После активации панели 
Area и перехода в режим Point (Точка) выберите интересующую точку измерений на АСМ-
изображении в графической зоне и щелкните в этом месте один раз левой кнопкой мыши. 
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Установленная точка измерений будет отображаться на АСМ-изображении символом X и 
соединяться с ранее установленной точкой измерений (отмечается символом +) отрезком 
прямой линии. Для перевода сканирующего устройства в новое положение установленной точки 
измерений необходимо на панели Area нажать кнопку Set position (рис. 3.7). 
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Рис. 3.5. Схема регистрации данных при проведении статической силовой спектроскопии 
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Рис. 3.6. Окно программы Surface Scan после получения АСМ-изображения 
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Рис. 3.7. Панель Area в режиме Point (Точка). Курсор мыши указывает на кнопку Set position для перевода зонда в 

установленную точку измерений X 

Для проведения спектроскопии рекомендуется, если неизвестны характеристики 
измеряемого материала и т.п., установить вертикальное положение зонда и величину нагрузки 
порядка 50% (индикатор Load в середине диапазона – установка с помощью регулятора Set 
point на панели параметров обратной связи Feedback, индикатор удлинения пьезотрубки Z 
примерно в середине). При необходимости допускается ручной подвод/отвод зонда к/от 
поверхности (на панели Main). 

Управление параметрами силовой спектроскопии производится на панели FvsD (от Force-
vs-Distance Curve), рис. 3.8. Значения параметров в таблице см. в руководстве. Вертикальными 
регуляторами в зоне Z distance устанавливаются верхняя (регулятор слева от индикатора) и 
нижняя (регулятор справа от индикатора) границы диапазона движения пьезотрубки при 
проведении измерения. На самом индикаторе установленные границы также указываются 
соответствующими отметками. При этом рабочий диапазон движения закрашивается зеленым 
цветом, треугольный маркер символически указывает текущее положение зонда относительно 
диапазона движения пьезотрубки. 

 

   

Рис. 3.8. Панель настройки параметров и управления спектроскопией FvsD (справа) и окно визуализации 
результатов измерений с активированными маркерами границ диапазона движения пьезотрубки (слева). Линии 

показывают связь между регуляторами и маркерами границ диапазона движения пьезотрубки 

Для первоначального измерения рекомендуется, чтобы установленный диапазон 
движения пьезотрубки составлял около 1/3 всего ее вертикального размаха (примерно как на 
рис. 3.8).  



ОДО «Микротестмашины» 

 56

Процедура статической силовой спектроскопии в расширенном варианте запускается 

командой меню Task > Spectroscopy in point или нажатием кнопки  в линейке инструментов. 
Также эту процедуру можно запустить из панели Main, установив в ее селекторе Task задачу 
Spectroscopy in point, а в селекторе Mode режим STATIC. После запуска процедуры открывается 
специализированное окно визуализации измеренных данных View spectroscopy data (рис. 3.8 
слева).  

Рекомендуется, чтобы значимая область полученного графика (т.е. наклонный участок 
кривой) занимал не менее 30% окна по горизонтали и находился в левой части окна. Т.е. 
горизонтальный участок слева вверху должен присутствовать, но быть минимальным. Это 
позволит избежать как опасности поломки зонда, так и преждевременного затупления острия. 
Добиться этого можно передвигая вертикальные маркеры в окне визуализации (левую и правую 
вертикальные оси), либо сдвигая вертикальными регуляторами на панели FvsD границы 
диапазона движения пьезотрубки. Связь между границами на графике и регуляторами на 
панели показана на рис. 3.8. Также необходимо обратить внимание на то, что начальный 
горизонтальный участок кривой подвода не был слишком мал – таким, чтобы на кривой отвода 
с запасом отрисовывался участок отрыва острия от поверхности. Пример полученной кривой 
подвода/отвода приведен на рис. 3.9. 

После завершения процедуры и построения графика функции статической силовой 
спектроскопии система автоматически останавливается. Измеренные данные, представленные 
на графике, могут быть сохранены в файле на диске в текстовом или графическом формате с 
использованием стандартного диалога сохранения файла. 

 
Для калибровки правой вертикальной оси нагрузки (усилия) в абсолютных единицах 

необходимо проделать следующие процедуры с полученной кривой. Сначала проверить 
установку известного значения жесткости кантилевера, используемого для измерений, записав 
его в поле Spring constant (или аналогично в общей панели калибровки Service > Calibrate). Значение 
вносится в единицах Н*м. Пример панелей для ввода значения жесткости кантилевера 
приведен на рис. 3.10. 

 

 
      

Рис. 3.9. Пример кривой подвода/отвода Рис. 3.10. Пример ввода значения жесткости 
кантилевера в общей панели калибровки программы 

(слева) или в таблице параметров панели FvsD 
(последняя строчка) 

Если точная величина жесткости кантилевера неизвестна, рекомендуется взять его 
типичное значение из паспорта зонда, обычно сообщаемого его изготовителем. 

Непосредственно калибровка измерительной системы может осуществляться либо с 
помощью функции автокалибровки (вызвать контекстное меню, нажав правую кнопку мыши в 
окне графика, и выбрать пункт Auto Calibrate ), либо вручную в следующем порядке.  

1. Зафиксировать установки верхней и нижней границ диапазона движения пьезотрубки 
(записать параметры Top, nm и Bottom, nm из таблицы параметров на панели FvsD либо 
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сохранить эти параметры как предустановенный набор (preset) – с помощью пункта 
<Add new> в селекторе над таблицей параметров на панели FvsD). 

2. В специализированном окне визуализации измеренных данных View spectroscopy 
data активировать отображение выбранного диапазона – Show selected range (рис. 3.11). 

3. При помощи вертикальных регуляторов на панели FvsD передвинуть границы 
диапазона движения пьезотрубки таким образом, чтобы маркеры в 
специализированном окне визуализации выделяли наклонную часть кривой 
подвода/отвода (рис. 3.12). Желательно, чтобы выделенный диапазон охватывал 
максимально возможный наклонный участок графика, но линия на графике оставалась 
как можно более прямой, чтобы минимизировать нелинейность расчетов и 
дальнейших измерений.  

Допускается верхнюю границу выделяемого диапазона (левый регулятор на 
панели = правый маркер на графике) установить в точку пересечения кривой подвода 
с осью нулевого значения (горизонтальная пунктирная линия на графике). Нижнюю 
границу выделяемого диапазона (правый регулятор на панели = левый маркер на 
графике) желательно установить на прямом участке наклонной части кривой, но до ее 
закругления (иногда встречается при измерении определенных типов материалов) при 
переходе к горизонтальной части слева вверху. 

 

 

Рис. 3.11. Активация отображения выбранного диапазона 

 

 

Рис. 3.12. Перемещение маркеров для выделения наклонного участка кривой подвода/отвода 

4. На поле графика вызвать контекстное меню, щелкнув правой кнопкой мыши, и 
выбрать команду Range Calibrate (Калибровка диапазона) (рис. 3.12 справа). В поле 
графика в правом нижнем углу отобразится текущее значение коэффициента 
пропорциональности k.  
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5. Если k = 1+8…10% (т.е. в лучшем случае k = 0,92…1.08), то дальнешую калибровку 
допускается не проводить. В противном случае необходимо вернуть зафиксированные 
в п.1 параметры верхней и нижней границ диапазона движения пьезотрубки, внеся 
записанные значения в соответствующие поля таблицы параметров на панели FvsD , 
и повторить процедуры по пп.2–5. 

 
По достижении коэффициента пропорциональности k = 0,92…1.08 калибровку можно 

считать завершенной (рис. 3.13) 
 

 

Рис. 3.13. Пример окна визуализации данных спектроскопии с рассчитанным коэффициентом пропорциональности 
наклонного участка k = 1.08 

3.5.2 Динамическая частотная спектроскопия 

Динамическая частотная спектроскопия является специальной функцией АСМ NT-206, 
позволяющая визуализировать зависимость одновременно трех параметров – амплитуды, 
частоты, расстояния зонд–образец – комплексно характеризующих взаимодействие зонда в 

динамическом режиме и измеряемой поверхности. Функция запускается нажатием кнопки  
(AFD) или командой меню Task > Dynamic force spectroscopy. После старта будет выведена 
вспомогательная панель AFD parameters (Рис. 3.14), в которой необходимо задать способ 
перемещения зонда относительно поверхности образца – с помощью пьезосканера при его 
вертикальном сжатии/растяжении (режим Piezotube controlling, Рис. 3.14 слева) или с помощью 
шагового двигателя и механизма подвода (режим Drive controlling, Рис. 3.14 справа). 

 

         

Рис. 3.14. Панель настроек для динамической силовой спектроскопии при осуществлении вертикального движения с 
помощью пьезосканера (слева) и шагового двигателя механизма подвода (справа). 

В режиме вертикального движения с помощью пьезосканера Piezotube controlling 
необходимо установить следующие параметры: 

 Distance 1 – начальная точка рабочего диапазона; 
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 Distance 2 – конечная точка рабочего диапазона; 
 Number of points – количество точек измерения в рабочем 

диапазоне; 
 Full length – информация о длине рабочего диапазона. 

В режиме вертикального движения с помощью шагового двигателя механизма подвода 
Drive controlling, необходимо ввести следующие параметры:  

 Number of points – количество точек измерения в рабочем 
диапазоне; 

 Drive step – количество элементарных шагов, которые двигатель 
должен произвести между точками измерений; 

 Full length – информация о длине рабочего диапазона; 
 Direction – направление вертикального движения механизма 

подвода, при котором будет измеряться характеристика Амплитуда–
Частота–Расстояние – либо только при сближении зонда и образца 

, либо только при их отводе  (во избежание влияния 
люфта). 

После установки необходимых параметров в панели AFD parameters непосредственно 
процесс измерения запускается нажатием кнопки  OK  в нижней части панели. В окне 

визуализации измеряемых данных функции AFD («Амплитуда–Частота–Расстояние») будут 
отображаться два двухмерных изображения: 

слева (AFD) – амплитуда колебаний кантилевера (соответствует вертикальной оси и 
определяется цветовой шкалой) как функция частоты колебаний (ось X / по горизонтали) и 
расстояния Distance между поверхностью образца и зондом (ось Y / по вертикали); 

справа (PhFD) – сдвиг фазы колебаний кантилевера (соответствует вертикальной оси и 
определяется цветовой шкалой) как функция частоты колебаний (ось X / по горизонтали) и 
расстояния Distance между поверхностью образца и зондом (ось Y / по вертикали). 

 

 

Рис. 3.15. Окно визуализации AFD-анализа (визуализация данных динамической силовой спектроскопии). 

В нижней половине окна визуализации система выводит кривую зависимости амплитуды 
колебаний кантилевера от частоты, полученную при последнем сканировании частотного 
диапазона (соответственно, на предшествующем текущему шаге по вертикали между образцом 
и зондом). 
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После выполнения заданной функции и получения соответствующих графиков система 
автоматически завершает процедуру измерений. Измеренные данные, представленные окне 
визуализации, могут быть сохранены в файле на диске в текстовом или графическом формате с 
использованием стандартного диалога сохранения файла. 
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